TaqMan® OpenArray® Genotyping

Getting Started Guide
Contents

About This Guide ......................................................... 9
- Purpose ................................................................. 9
- Prerequisites .......................................................... 9
- Safety information ..................................................... 9
  - Safety alert words .................................................... 9
  - SDSs ................................................................. 10
  - Safety labels on instruments ...................................... 11

CHAPTER 1
Introduction .............................................................. 13
- System overview ....................................................... 13
  - Platform components .............................................. 13
  - About data collection ............................................. 14
- Plate overview ........................................................ 15
  - Sample plate ......................................................... 15
  - TaqMan® OpenArray® Genotyping Plate ...................... 16
- About genotyping experiments .................................. 17
  - What is a genotyping experiment? ............................. 17
  - How TaqMan® genotyping experiments work ................ 17
- Workflow ............................................................... 19

CHAPTER 2
Prepare the OpenArray® 384-Well Sample Plates ............ 21
- Required materials ................................................... 22
- Prepare the DNA samples .......................................... 23
  - Quality of DNA .................................................... 23
  - Quantity of DNA .................................................. 23
  - Quantification procedure for human DNA samples ....... 23
- Create a sample information file (*.csv) for sample tracking ........................................ 25
  - Include no template controls .................................. 25
  - Use the Sample Tracking & Calculator Tool ............... 25
  - Use a spreadsheet or simple text program ................. 30
  - Export sample information from an existing *.nix file .... 30
- Set up the sample plates ........................................... 33
  - About the sample plate ......................................... 33
  - TaqMan® OpenArray® Genotyping Plate formats ........... 34
  - Format 16 .......................................................... 35
  - Format 32 .......................................................... 37
 CHAPTER 3  
**Prepare the TaqMan® OpenArray® Genotyping Plates**  ....... 45

- Required materials ................................. 46
  - TaqMan® OpenArray® Genotyping Plates ............... 46
  - Other consumables and equipment .................... 47
- Storage conditions .................................. 48
- Prepare for loading ................................ 49
- Place a TaqMan® OpenArray® Genotyping Plate in a plate holder .......................... 50
  - Important guidelines for handling the plate .......... 50
  - Place the plate in the plate holder ................. 50
- Load the OpenArray® AutoLoader Tip Blocks ...... 52
- Run the OpenArray® AutoLoader .................... 54
  - Set up the AutoLoader .................................. 55
  - Load the sample ......................................... 57
- Seal the TaqMan® OpenArray® Genotyping Case .... 58
  - Insert the loaded plate into a TaqMan® OpenArray® Genotyping Case .................. 58
- Clean the TaqMan® OpenArray® Genotyping Case ... 58
- Complete loading for the remaining plates ........ 60
- Perform thermal cycling .............................. 61
  - Qualified thermal cyclers .......................... 61
  - Storage ................................................. 61
- Guidelines for high-throughput loading ............. 62
  - Before you begin loading ......................... 62
  - During and after loading .......................... 62

 CHAPTER 4  
**Perform Imaging**  .................................. 63

- About the data files ................................ 64
  - TaqMan® OpenArray® Genotyping Plate setup files (*.spf) ............... 64
  - Project files (*.nix) .................................. 64
  - TaqMan® OpenArray® Genotyping Plate data files (*.spd) ............... 65
  - Sample information files (*.csv) ..................... 65
- Set up the software ................................ 66
  - Start the OpenArray® instrument and software .... 66
  - Copy the plate setup file (*.spf) to your computer .... 66
Contents

CHAPTER 5

5. Analyze the Run Data ......................................................... 81
   View the results ................................................................. 82
       Open a project file ......................................................... 82
       View data in the Assays pane ......................................... 83
       View data in the Scatter Plot ......................................... 85
       Datapoint color descriptions ........................................... 87
   View data in the Samples pane ............................................. 88
       Samples pane column descriptions .................................. 90
   (Optional) Modify clustering parameters ............................... 92
       About the Auto functions ............................................... 92
       Save your changes to the project file ............................... 92
       Set outliers ................................................................. 93
       Adjust genotyping clusters ............................................. 94
       Adjust stringency .......................................................... 97
       Adjust tolerance ............................................................ 98
       Set Don’t Call samples ................................................... 99
   Exclude genotyping clusters from analysis ........................... 99
   Draw genotyping clusters .................................................. 101
   (Optional) Modify project files ........................................... 102
       Add plate data files (*.spd) ............................................ 102
       Remove plate data files (*.spd) ....................................... 103
       Set project parameters .................................................. 103
   (Optional) Publish data ........................................................ 105
       Copy and paste Scatter Plots ........................................... 105
       Export genotype tables ................................................... 105
       Export *.csv files ........................................................ 106
   (Optional) Perform downstream analysis ............................... 108
       Features ................................................................. 108
       Export to the AutoCaller software .................................. 108

APPENDIX A

5. Maintenance ................................................................. 109
   Contact Applied Biosystems ............................................. 109
   Required materials ........................................................ 110
   Computer ................................................................. 111
       Install the software ...................................................... 111
       Open the software for the first time ................................ 111
       Clean the hard drive ...................................................... 112
Contents

OpenArray® AutoLoader and accessories .......................................................... 112
  Clean the exterior ................................................................. 112
  Clean the interior ............................................................... 112
  Calibrate the AutoLoader ...................................................... 113
  Clean the accessories ........................................................ 113
OpenArray® instrument ................................................................. 114
  Clean the lens ...................................................................... 114
  Clean the sample block ......................................................... 116
  Clean the exterior ............................................................... 116

APPENDIX B Troubleshooting ................................................................. 117
  Loading sample .................................................................... 117
  Imaging ............................................................................... 117
  Analysis ............................................................................. 120
  Miscellaneous ...................................................................... 122

APPENDIX C DNA Calculator ............................................................... 123
  About the Sample Tracking & Calculator Tool ....................... 123
  Calculate the starting concentration of gDNA ....................... 123
    Example ........................................................................ 124
  Calculate the volume of master mix and water ..................... 125
    Example ........................................................................ 126

APPENDIX D Thermal Cycler Protocols ................................................ 127
  Dual Flat Block GeneAmp® PCR System 9700 ......................... 127
  Bio-Rad® thermal cycler protocol ......................................... 127
  Protocol ........................................................................... 128
  Thermo Electron PX2 thermal cycler protocol ....................... 129

APPENDIX E Instrument Warranty Information ............................. 131
  Computer configuration ......................................................... 131
  Limited product warranty ...................................................... 131
    Limited warranty ............................................................. 131
    Warranty period effective date ........................................ 132
    Warranty claims ................................................................ 132
    Warranty exceptions ....................................................... 132
    Warranty limitations ....................................................... 132
  Damages, claims, and returns ............................................... 134
    Damages ........................................................................ 134
    Claims .......................................................................... 134
    Returns ......................................................................... 134
APPENDIX F

Safety ............................................................ 135

Instrumentation safety ......................................................... 136
  Symbols on instruments ...................................................... 136
  Locations of safety labels on instruments ................................. 137
  General instrument safety .................................................... 138
  Physical hazard safety ....................................................... 139
  Electrical safety ............................................................ 140
  Bar code scanner laser safety ............................................... 140
  Workstation safety .......................................................... 141
  Safety and electromagnetic compatibility (EMC) standards ............ 141

Chemical safety ............................................................. 143
  General chemical safety ...................................................... 143
  SDSs .............................................................................. 143
  Chemical waste safety ......................................................... 144
  Biological hazard safety ....................................................... 145

Documentation and Support ................................................. 147

System documentation .......................................................... 147
Related documentation .......................................................... 147
Obtaining support ................................................................. 148

Bibliography ................................................................. 149

Glossary ................................................................. 151

Index ................................................................. 153
About This Guide

Purpose

The TaqMan® OpenArray® Genotyping Getting Started Guide provides information about the OpenArray® system, including step-by-step procedures to:

- Prepare a TaqMan® OpenArray® Genotyping Plate, using the OpenArray® AutoLoader and OpenArray® Case Sealing Station.
- Run a TaqMan OpenArray Genotyping Plate on the OpenArray® instrument, then analyze the data with the OpenArray® SNP Genotyping Analysis Software.
- Maintain the OpenArray® platform.

Prerequisites

This guide assumes that your OpenArray® platform has been installed by an Applied Biosystems service representative.

This guide uses conventions and terminology that assume a working knowledge of the Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

Safety information

Note: For general safety information, see this section and Appendix F, “Safety” on page 135. When a hazard symbol and hazard type appear by a chemical name or instrument hazard, see the “Safety” Appendix for the complete alert on the chemical or instrument.

Safety alert words

Four safety alert words appear in Applied Biosystems user documentation at points in the document where you need to be aware of relevant hazards. Each alert word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of observation or action, as defined below:

IMPORTANT! – Indicates information that is necessary for proper instrument operation or accurate chemistry kit use.

CAUTION! – Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.
WARNING! – Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

DANGER! – Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. This signal word is to be limited to the most extreme situations.

Except for IMPORTANTs, each safety alert word in an Applied Biosystems document appears with an open triangle figure that contains a hazard symbol. These hazard symbols are identical to the hazard symbols that are affixed to Applied Biosystems instruments (see “Safety symbols” on page 136).

SDSs

The Safety Data Sheets (SDSs) for any chemicals supplied by Applied Biosystems or Ambion are available to you free 24 hours a day. For instructions on obtaining SDSs, see “SDSs” on page 143.

IMPORTANT! For the SDSs of chemicals not distributed by Applied Biosystems or Ambion contact the chemical manufacturer.
Safety labels on instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on Applied Biosystems instruments in combination with the safety symbols described in the preceding section.

<table>
<thead>
<tr>
<th>Hazard symbol</th>
<th>English</th>
<th>Français</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td><strong>CAUTION!</strong> Hazardous chemicals. Read the Safety Data Sheets (SDSs) before handling.</td>
<td><strong>ATTENTION!</strong> Produits chimiques dangereux. Lire les fiches techniques de sûreté de matériels avant toute manipulation de produits.</td>
</tr>
<tr>
<td></td>
<td><strong>CAUTION!</strong> Hazardous waste. Refer to SDS[s] and local regulations for handling and disposal.</td>
<td><strong>ATTENTION!</strong> Déchets dangereux. Lire les fiches techniques de sûreté de matériels et la régulation locale associées à la manipulation et l’élimination des déchets.</td>
</tr>
<tr>
<td>!</td>
<td><strong>CAUTION!</strong> Hot surface.</td>
<td><strong>ATTENTION!</strong> Surface brûlante.</td>
</tr>
<tr>
<td>!</td>
<td><strong>CAUTION!</strong> Class 2(II) visible and/or invisible laser radiation present when using the instrument and barcode scanner. Do not stare directly into the beam or view directly with optical instruments.</td>
<td><strong>ATTENTION!</strong> Rayonnement visible ou invisible d’un faisceau laser de Classe 2(II) en cas d’ouverture et de neutralisation des dispositifs de sécurité. Ne pas regarder le faisceau directement ou au travers d’un instrument optique.</td>
</tr>
<tr>
<td>!</td>
<td><strong>CAUTION!</strong> UV LIGHT HAZARD. UV light may harm your skin and eyes. Keep at least 25 cm distance.</td>
<td><strong>ATTENTION!</strong> Dangers liés aux rayons UV. Les rayons UV peuvent endommager votre peau et vos yeux. Gardez une distance de plus de 25 cm.</td>
</tr>
<tr>
<td>!</td>
<td><strong>CAUTION!</strong> Moving parts. Crush/pinch hazard.</td>
<td><strong>ATTENTION!</strong> Pièces en mouvement, risque de pincement et/ou d’écrasement.</td>
</tr>
</tbody>
</table>
CHAPTER 1

Introduction

This chapter covers:

■ System overview .......................................................... 13
■ Plate overview .............................................................. 15
■ About genotyping experiments ....................................... 17
■ Workflow ...................................................................... 19

System overview

The OpenArray® system uses fluorescence-based polymerase chain reaction (PCR) reagents to provide qualitative detection of targets using post-PCR (endpoint) analysis.

Use the OpenArray® system to perform genotyping experiments to identify slight variations in genes within a population. The OpenArray® system:

• Provides PCR-based endpoint analysis of tens to hundreds of single nucleotide polymorphism (SNPs) across thousands to tens of thousands of samples.
• Allows a single researcher to load, amplify, and scan 16 TaqMan® OpenArray® Genotyping Plates in an 8-hour workday. Each genotyping plate is preloaded with 16 to 256 TaqMan® assays.
• Provides data that is ~99.7% concordant with data generated with TaqMan assays on an Applied Biosystems Real-Time PCR System.

Platform components

The OpenArray® platform consists of the following components:

• OpenArray® AutoLoader – Loads your samples onto a TaqMan® OpenArray® Genotyping Plate.
• OpenArray® Case Sealing Station – Seals the TaqMan® OpenArray® Genotyping Cases.
• OpenArray® instrument – Performs imaging of the genotyping plates.
• Computer – Connects to the OpenArray® instrument. The OpenArray® SNP Genotyping Analysis Software installed on the computer analyzes the run data, then calls the genotypes.

Note: You can also perform downstream analysis with Applied Biosystems AutoCaller™ Software. For more information, see page 108.
Genotyping experiments require two steps: thermal cycling (PCR amplification), followed by endpoint detection of the resulting fluorescence signals.

While the OpenArray® instrument performs the endpoint detection, you need a standalone thermal cycler to perform PCR amplification. Purchase a thermal cycler that has been qualified for use with the TaqMan® OpenArray® Genotyping Plates. The following thermal cyclers are qualified for use with the genotyping plates:

- Dual Flat Block GeneAmp® PCR System 9700
- Bio-Rad® thermal cycler with Slide Chambers Dual Block Alpha Unit
- Thermo Electron PX2 thermal cycler

Note: Contact your Applied Biosystems service representative for more information on the thermal cyclers.

About data collection

The OpenArray® instrument collects raw fluorescence data after thermal cycling (PCR amplification) has been performed. A data collection point (datapoint) on the OpenArray® instrument consists of three phases:

1. **Excitation** – The instrument illuminates all through-holes of the genotyping plate, exciting the fluorophores in each reaction.

2. **Emission** – The instrument optics collect the residual fluorescence emitted from the through-holes of the genotyping plate. The resulting image consists only of light that corresponds to the range of emission wavelengths.

3. **Collection** – The instrument assembles a digital representation of the residual fluorescence collected over a fixed time interval, then stores the raw fluorescence image for analysis.

After a run, the OpenArray software uses regions of interest (ROI), optical, dye, and background calibration data to determine the location and intensity of the fluorescence signals in each read, the dye associated with each fluorescence signal, and the significance of the signal.
Plate overview

The OpenArray® system requires two plate types:

- OpenArray® 384-Well Sample Plate (sample plate) (this page)
- TaqMan® OpenArray® Genotyping Plate (genotyping plate) (page 16)

Sample plate

The OpenArray 384-Well Sample Plate is a 384-well reaction plate. You combine the TaqMan® OpenArray® Genotyping Master Mix and your DNA sample in the sample plate, then use the OpenArray AutoLoader to transfer the mixture from the sample plate to a genotyping plate(s).

IMPORTANT! The well dimensions of the OpenArray 384-Well Sample Plates are specifically suited for use with the OpenArray AutoLoader. Applied Biosystems does not recommend the use of other microtiter plates with the AutoLoader.
TaqMan® OpenArray® Genotyping Plate

The TaqMan OpenArray Genotyping Plate is a 63-mm × 19-mm mid-density reaction plate. There are 3072 reaction through-holes in the plate; individual through-holes are preloaded with a TaqMan assay and can accommodate a 33-nL reaction volume.

As shown in the figure below, the genotyping plate is divided into 48 subarrays; each subarray consists of 64 through-holes. Hydrophilic and hydrophobic coatings allow reagents to be held within the through-holes.

Available TaqMan® assays

When you order a genotyping plate, you select the TaqMan assay(s) to include in the plate. The assays are dried-down and preloaded into the genotyping plate. You can select any combination of the following:

- TaqMan® SNP Genotyping Assays
- Custom TaqMan® SNP Genotyping Assays
- TaqMan® Drug Metabolism Genotyping Assays

Available formats

Each through-hole in a genotyping plate may contain a single assay. The number of assays in the genotyping plate and the number of samples you can load in the plate depend on the format you select. For more information on each format, see “Set up the sample plates” on page 33.
About genotyping experiments

What is a genotyping experiment?

A genotyping experiment (also known as an allelic discrimination experiment) is an endpoint experiment used to determine the genotype of unknown samples. With this experiment type, you can differentiate two alleles of a single nucleotide polymorphism (SNP).

A genotyping experiment determines if unknown samples are:

• Allele 1 homozygotes (samples having only allele 1)
• Allele 2 homozygotes (samples having only allele 2)
• Heterozygotes (samples having both allele 1 and allele 2)

Components

Genotyping experiments include the following samples and controls:

• **Sample** – The DNA sample in which the genotype of the target is unknown.
• (Optional) **Replicates** – Identical reactions containing identical components and volumes.
• (Optional) **No template controls (NTCs)** – Samples that contain water or buffer instead of template; also known as negative controls. NTCs should not amplify.
• (Optional) **Positive controls** – Samples that contain known genotypes (homozygotes for allele 1, homozygotes for allele 2, and heterozygotes for alleles 1 and 2).

How TaqMan® genotyping experiments work

In TaqMan® genotyping experiments, the PCR includes a specific fluorescent-dye-labeled probe for each allele of the target SNP. The probes contain different fluorescent reporter dyes to differentiate each allele.

When you order a genotyping plate, you select the assay(s) appropriate for your experiment (see “Available TaqMan® assays” on page 16). The assays are dried-down and preloaded into the genotyping plate. Each assay contains:

• A reporter dye at the 5′ end of each probe:
  – VIC® dye is linked to the 5′ end of the allele 1 probe
  – FAM™ dye is linked to the 5′ end of the allele 2 probe
  – Forward primer
  – Reverse primer

• A minor groove binder (MGB)

  This modification increases the melting temperature (Tm) of probes without increasing probe length (Afonina *et al.*, 1997; Kutyavin *et al.*, 1997), thereby allowing the design of shorter probes. Consequently, the TaqMan MGB probes exhibit greater differences in Tm values between matched and mismatched probes; greater differences in Tm values provide accurate genotyping.

• A nonfluorescent quencher (NFQ) at the 3′ end of the probe

  Because the quencher does not fluoresce, real-time PCR systems can measure reporter dye contributions accurately.
During PCR, each probe anneals specifically to its complementary sequence between the forward and reverse primer sites. The DNA polymerase can cleave only probes that hybridize to their specific SNP allele (match). Cleavage separates the reporter dye from the quencher dye, substantially increasing fluorescence of the reporter dye. Thus, the fluorescence signals generated during PCR amplification indicate the alleles that are present in the sample.

The figure below illustrates results from matches and mismatches between target and probe sequences in TaqMan SNP Genotyping Assays (Livak et al., 1995). A mismatch between a probe and a SNP allele greatly reduces the efficiency of probe hybridization. Furthermore, the DNA polymerase is likely to displace the mismatched probe rather than to cleave it to release reporter dye. In other words, matches generate signal; mismatches do not generate signal.

The table below summarizes the possible results of the genotyping experiment example shown above.

<table>
<thead>
<tr>
<th>A substantial increase in...</th>
<th>Indicates...</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIC® dye fluorescence only</td>
<td>Allele 1 homozygotes</td>
</tr>
<tr>
<td>FAM™ dye fluorescence only</td>
<td>Allele 2 homozygotes</td>
</tr>
<tr>
<td>VIC® dye and FAM™ dye fluorescence</td>
<td>Heterozygotes</td>
</tr>
</tbody>
</table>
Workflow

Chapter 2, Prepare the OpenArray® 384-Well Sample Plates
1. Prepare the DNA samples.
2. Set up the OpenArray® 384-Well Sample Plates. Sample plate setup is dependent on the format of your TaqMan® OpenArray® Genotyping Plates.
3. Load the DNA samples into the sample plates.
4. (Optional) Store the sample plates.

Chapter 3, Prepare the TaqMan® OpenArray® Genotyping Plates
1. Prepare for loading.
2. Place a TaqMan® OpenArray® Genotyping Plate in an OpenArray® AutoLoader Plate Holder.
3. Load the OpenArray® AutoLoader Tip Blocks.
4. Run the OpenArray® AutoLoader.
5. Seal the TaqMan® OpenArray® Genotyping Case.
6. Perform thermal cycling.

Chapter 4, Perform Imaging
1. Set up the OpenArray® SNP Genotyping Analysis Software.
2. Enter sample information in the OpenArray software.
3. Place the loaded TaqMan® OpenArray® Genotyping Plates in the OpenArray® instrument, then perform an imaging run.

Chapter 5, Analyze the Run Data
1. View the results.
2. (Optional) Modify clustering parameters.
3. (Optional) Modify project files (*.nix).
4. (Optional) Publish data.
5. (Optional) Perform downstream analysis using the AutoCaller™ Software.
Chapter 1  Introduction

Workflow
CHAPTER 2

Prepare the OpenArray® 384-Well Sample Plates

This chapter covers:

- Required materials .......................................................... 22
- Prepare the DNA samples .................................................... 23
- Create a sample information file (*.csv) for sample tracking ........ 25
  Use the Sample Tracking & Calculator Tool ................................. 25
  Use a spreadsheet or simple text program ............................... 30
  Export sample information from an existing *.nix file .................. 30
- Set up the sample plates ...................................................... 33
  Format 16 ........................................................................... 35
  Format 32 ........................................................................... 37
  Format 64 ........................................................................... 39
  Format 128 ........................................................................ 40
  Format 192 ......................................................................... 41
  Format 256 ......................................................................... 42
- Load DNA samples and master mix into the sample plate(s) .......... 43
- (Optional) Store sealed sample plates ..................................... 44

In this chapter, you prepare your DNA sample, set up the OpenArray® 384-Well Sample Plates, then load your DNA sample into the sample plates. In Chapter 3, you will use the OpenArray® AutoLoader to transfer sample from the prepared sample plates to TaqMan® OpenArray® Genotyping Plates.

1. Prepare the DNA samples.
2. Set up the OpenArray® 384-Well Sample Plates. Sample plate setup is dependent on the format of your TaqMan® OpenArray® Genotyping Plates.
3. Load the DNA samples into the sample plates.
4. (Optional) Store the sample plates.
## Required materials

<table>
<thead>
<tr>
<th>Product</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For preparing your DNA samples</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® RNase P Detection Reagents Kit</td>
<td>Applied Biosystems</td>
<td>4316831</td>
</tr>
<tr>
<td>This kit contains RNase P gene primers and probe: 20X Primer and TaqMan® Probe (FAM™ dye) mix.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® DNA Template Reagents Kit</td>
<td>Applied Biosystems</td>
<td>401970</td>
</tr>
<tr>
<td>This kit contains DNA template standards.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® Universal PCR Master Mix, No AmpErase® UNG</td>
<td>Applied Biosystems</td>
<td>4324018</td>
</tr>
<tr>
<td>Genomic DNA sample</td>
<td>User-supplied</td>
<td>——</td>
</tr>
<tr>
<td>See &quot;Prepare the DNA samples&quot; on page 23.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DNase-free, sterile-filtered water</td>
<td>Major laboratory suppliers (MLS)</td>
<td>——</td>
</tr>
<tr>
<td><strong>For setting up and loading the sample plates</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpenArray® 384-Well Sample Plates</td>
<td>Applied Biosystems</td>
<td>4406947</td>
</tr>
<tr>
<td>(Optional) Fine-tip marker</td>
<td>MLS</td>
<td>——</td>
</tr>
<tr>
<td>TaqMan® OpenArray® Genotyping Master Mix</td>
<td>Applied Biosystems</td>
<td>4404846</td>
</tr>
<tr>
<td>Corning® 96 Well Microplate Aluminum Sealing Tape, Nonsterile</td>
<td>Corning Life Sciences</td>
<td>6570</td>
</tr>
<tr>
<td><strong>For general use</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Powder-free nitrile gloves</td>
<td>MLS</td>
<td>——</td>
</tr>
<tr>
<td>Lint-free wipes</td>
<td>MLS</td>
<td>——</td>
</tr>
<tr>
<td>Disposable transfer pipettes</td>
<td>MLS</td>
<td>——</td>
</tr>
<tr>
<td>Pipettes, P10 to P1000</td>
<td>MLS</td>
<td>——</td>
</tr>
<tr>
<td>Pipette tips, 10 to 100 μL</td>
<td>MLS</td>
<td>——</td>
</tr>
<tr>
<td>Centrifuge with plate adaptor</td>
<td>MLS</td>
<td>——</td>
</tr>
<tr>
<td>Vortexer</td>
<td>MLS</td>
<td>——</td>
</tr>
</tbody>
</table>
Prepare the DNA samples

Quality of DNA

Be sure that the DNA you use for genotyping experiments:

- Is extracted from the raw material you are testing with an optimized protocol; salting out procedures and crude lysates are not recommended
- Does not contain PCR inhibitors
- Has an A_{260/230} ratio between 1.7 and 1.9
- Has an A_{260/280} ratio between 1.7 and 1.9
- Is intact as visualized by gel electrophoresis
- Has not been heated above 60 °C; temperatures above 60 °C can cause degradation

Quantity of DNA

Applied Biosystems recommends that you quantify the amount of genomic DNA in your samples. Note that:

- The OpenArray plate requires 250 copies of haploid genome for each individual through-hole reaction.
- For optimal cluster plot results, it is important to normalize all genomic DNA samples in an experiment so that each through-hole receives the same input quantity of sample.

For an example quantification procedure, see “Quantification procedure for human DNA samples” (this page).

Quantification procedure for human DNA samples

Template amount

The recommended amount of template for each through-hole reaction in an OpenArray plate is 250 copies of the haploid genome, equivalent to 0.84 ng for human DNA samples. Quantify human DNA samples using the TaqMan® RNase P Detection Reagents Kit and the TaqMan® DNA Template Reagents Kit.

Note: The recommended starting concentration for human DNA samples is 50 ng/μL. See Appendix C, “DNA Calculator” on page 123.
Quantify human DNA samples

Generate a standard curve using the DNA template standards provided in the TaqMan DNA Template Reagents Kit and the RNase P gene primers and probe provided in the TaqMan RNase P Detection Reagents Kit.

Note: Refer to the appropriate instrument user guide for detailed instructions on performing and analyzing runs.

1. Create and set up a sequence detector plate document.

2. Prepare the reaction plate using the following components:
   - 2X TaqMan® Universal PCR Master Mix, No AmpErase® UNG
   - 20X Primer and TaqMan® Probe (FAM™ dye) mix
   - DNA template standard or genomic DNA sample
   - DNase-free, sterile-filtered water

   Use at least three replicates of each standard or sample, and use all five DNA standards to ensure an accurate standard curve is generated. The range of known copy number should bracket anticipated copy numbers of the unknown samples on the same reaction plate.

3. Run the reaction plate on an Applied Biosystems Real-Time PCR System using the following thermal cycling conditions:

<table>
<thead>
<tr>
<th>AmpliTaq Gold® enzyme activation</th>
<th>PCR</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOLD</td>
<td>CYCLE (40 cycles)</td>
</tr>
<tr>
<td>Denature</td>
<td>Anneal/extend</td>
</tr>
<tr>
<td>Time 10 min</td>
<td>15 sec</td>
</tr>
<tr>
<td>Temp 95 °C</td>
<td>92 °C</td>
</tr>
</tbody>
</table>

4. Generate a standard curve to quantify the amount of DNA in each sample.

The recommended starting concentration for human DNA samples is 50 ng/μL. See Appendix C, “DNA Calculator” on page 123.
Create a sample information file (*.csv) for sample tracking

Most researchers maintain stocks of gDNA samples in individual tubes or in 96-well stock plates. However, samples to be used with the OpenArray® system must be transferred first to a OpenArray® 384-Well Sample Plate, and then to a TaqMan® OpenArray® Genotyping Plate.

IMPORTANT! To ensure accurate data results, you must correctly track the sample IDs from format to format.

Applied Biosystems recommends that you create a sample information file (*.csv) to track your samples. Prior to imaging the genotyping plates, you can import the *.csv file into the OpenArray software.

You can create a sample information file in one of three ways:

- (Recommended) Use the Sample Tracking & Calculator Tool (this page)
- Use a spreadsheet or simple text program (page 30)
- Export sample information from an existing *.nix file (page 30)

Include no template controls

Applied Biosystems strongly recommends that you include at least one no template control (NTC) per genotyping plate. NTCs serve as negative controls, and are also useful in data analysis. When adding NTCs to the 96-well stock plate, place one NTC in each section of the stock plate to ensure that the NTCs are plated in the correct location in the genotyping plate. Also follow this procedure for any positive controls (for example, CEPH DNA).

Use the Sample Tracking & Calculator Tool

About the Sample Tracking & Calculator Tool

The Sample Tracking & Calculator Tool is a spreadsheet created with the Microsoft® Excel® Software. Applied Biosystems provides the Sample Tracking & Calculator Tool during training.

Applied Biosystems recommends that you use the Sample Tracking & Calculator Tool to convert the sample IDs to the appropriate format. When you use the tool, you only need to enter the sample IDs once, then the process of transferring the sample information from format to format is automatic.

Standard vs. modified spreadsheet

To ensure that the samples are tracked correctly, you must use an appropriate spreadsheet in the Sample Tracking & Calculator Tool. The spreadsheet that you use depends on:

- The OpenArray plate format that you are loading the samples into (Format 16, 32, 64, 128, 192, or 256) and
- The method that you use to transfer the samples from individual tubes or 96-well stock plates to the OpenArray 384-Well Sample Plate(s)

Applied Biosystems provides a standard spreadsheet in the Sample Tracking & Calculator Tool. You can use the standard spreadsheet if you load samples into a Format 64 (64 × 48) genotyping plate and use a 12-channel pipette to transfer samples. Otherwise, you must modify the standard spreadsheet to create the correct *.csv file for imaging.
Chapter 2  Prepare the OpenArray® 384-Well Sample Plates

Create a sample information file (*.csv) for sample tracking

Note: If you are unfamiliar with the Excel software, you can contact Applied Biosystems Technical Support for help with modifying the spreadsheet.

Example in this section

The standard spreadsheet was used for the example experiment illustrated in this section. In the example experiment:

- The Format 64 genotyping plate (64 × 48) was used.
- A 12-channel pipette with 9-mm spacing was used. The 384-well sample plates have 4.5-mm spacing; due to the 9-mm spacing of the pipette, sample was added to every other well in the 384-well sample plate. That is, all samples from row A of the 96-well plate were transferred to the odd-numbered wells of row A in the 384-well sample plate; all samples from row B of the 96-well plate were transferred to the even-numbered wells of row A in the 384-well sample plate, and so on.

Edit the spreadsheet

1. Open the Sample Tracking & Calculator Tool to start the Excel software.
2. Select the **Entry for Samples – List Format** tab.
3. Enter the sample IDs next to the appropriate well locations. You can enter up to four 96-well plates per spreadsheet (four 96-well plates are equal to one 384-well sample plate).

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2 96 well plate #</td>
<td>Well Location</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>A01</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>A02</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>A03</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>A04</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td>A05</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
<td>A06</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
<td>A07</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>A08</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>A09</td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>A10</td>
</tr>
<tr>
<td>12</td>
<td>1</td>
<td>A11</td>
</tr>
<tr>
<td>13</td>
<td>1</td>
<td>A12</td>
</tr>
<tr>
<td>14</td>
<td>1</td>
<td>B01</td>
</tr>
<tr>
<td>15</td>
<td>1</td>
<td>B02</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>B03</td>
</tr>
<tr>
<td>17</td>
<td>1</td>
<td>B04</td>
</tr>
<tr>
<td>18</td>
<td>1</td>
<td>B05</td>
</tr>
<tr>
<td>19</td>
<td>1</td>
<td>B06</td>
</tr>
<tr>
<td>20</td>
<td>1</td>
<td>B07</td>
</tr>
<tr>
<td>21</td>
<td>1</td>
<td>B08</td>
</tr>
<tr>
<td>22</td>
<td>1</td>
<td>B09</td>
</tr>
<tr>
<td>23</td>
<td>1</td>
<td>B10</td>
</tr>
<tr>
<td>24</td>
<td>1</td>
<td>B11</td>
</tr>
<tr>
<td>25</td>
<td>1</td>
<td>B12</td>
</tr>
</tbody>
</table>

For each 96-well plate in the spreadsheet, the sample IDs are color-coded in groups of six, using alternate colors.

4. Select the Entry for Samples – Plate Format tab, then confirm that the three plate views correspond to the layout of your stock gDNA plate:

<table>
<thead>
<tr>
<th>Plate view</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-well plate views (up to four 96-well plates)</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>N1</td>
</tr>
<tr>
<td>B</td>
<td>N11</td>
</tr>
<tr>
<td>C</td>
<td>N23</td>
</tr>
<tr>
<td>D</td>
<td>N35</td>
</tr>
<tr>
<td>E</td>
<td>N47</td>
</tr>
<tr>
<td>F</td>
<td>N59</td>
</tr>
<tr>
<td>G</td>
<td>N71</td>
</tr>
<tr>
<td>H</td>
<td>N83</td>
</tr>
</tbody>
</table>
Chapter 2  Prepare the OpenArray® 384-Well Sample Plates

Create a sample information file (*.csv) for sample tracking

### Plate view

384-well plate view (one 384-well plate)

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Genotyping plate views (up to eight genotyping plates)

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
<th>N</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

TagMan® OpenArray® Genotyping Getting Started Guide
Create a sample information file (*.csv) for sample tracking

1. (Optional) To track the eight plate areas of the 384-well sample plate to the eight genotyping plates, you can enter barcodes into the corresponding boxes. The barcode is located on the genotyping plate and on its packaging.

2. Select File > Save to save the spreadsheet in the Excel software.

3. Save the spreadsheet as a *.csv file:
   a. Select File > Save As.
   b. Browse to a save location, enter a file name, then select *.csv as the file type.
   c. Click Save.

The figure below is an example of a *.csv file generated with the Sample Tracking & Calculator Tool (the figure includes only a partial list of sample information). Prior to imaging the genotyping plate, use this file to import sample information into the OpenArray software, as described in “Import sample information from a *.csv file” on page 71.
Create a sample information file (*.csv) for sample tracking

**Use a spreadsheet or simple text program**

1. Open a new file in a simple text program or in a spreadsheet program (such as Microsoft® Excel® Software).

2. (Recommended) Label the file with the same unique identifier as the sample plate.

3. In Row 1, enter the column headings:
   a. You must include the following columns:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Column description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SampleInfo.Address</td>
<td>The well address of the sample on the sample plate (for example, A1)</td>
</tr>
<tr>
<td>SampleInfo.SampleID</td>
<td>Identifying information for the sample (user-defined)</td>
</tr>
<tr>
<td>SampleInfo.Description</td>
<td>A description of the sample (user-defined)</td>
</tr>
</tbody>
</table>

   b. (Optional) Add new columns (user-defined) to the right of the required columns.

4. In the remaining rows, enter information for each sample in the sample plate. Follow these guidelines:
   - Include all samples and all NTCs in the sample plate.
   - Enter information for only one sample per row.

   Note: You can have a maximum of 385 rows: One row for the column headings, and up to 384 rows with sample information.

5. Save the file as a comma-delimited (*.csv) file. Prior to imaging the genotyping plate, use this file to import sample information into the OpenArray software, as described in “Import sample information from a *.csv file” on page 71.

**Export sample information from an existing *.nix file**

1. On the computer, start the OpenArray software:
   - Double-click the software icon.
   - or
   - Select Start > All Programs > BioTrove > OpenArray® SNP Genotyping Analysis Software <version number> > OpenArray® SNP Genotyping Analysis Software.
     The software opens a new (empty) project file (*.nix).

2. Select File > Open, then browse to and select the desired project file (*.nix).
Chapter 2  Prepare the OpenArray® 384-Well Sample Plates

Create a sample information file (*.csv) for sample tracking

3. In the Samples pane, select a sample from a genotyping plate that contains the information you want to export.

Note: You can export sample information for only one genotyping plate at a time. If you select more than one sample, the software will export information for the genotyping plate that contains the last sample you selected.

4. In the Samples pane, click Edit to open the Sample Information dialog box for the selected sample.

5. Export the sample information to one *.csv file for all loads (1 to 3 loads) or to a separate *.csv file for each load:
   - To export to one *.csv file for all loads (1 to 3 loads):
     a. In the Sample Information dialog box, click Export.
Chapter 2  Prepare the OpenArray® 384-Well Sample Plates

Create a sample information file (*.csv) for sample tracking

2. Create a sample information file (*.csv) for sample tracking

b. Browse to a save location, enter a file name, then click **Save**. The software exports the sample information for 1 to 3 loads into a single *.csv file.

   **Note:** The software exports only the rows required for the selected plate areas. The software does not export all 384 rows for each of the sample plates.

   - **To export to a separate *.csv file for each load:**
     a. Click **next to appropriate load number to open the Sample Plate dialog box.**

     ![Sample Plate dialog box](image)

     b. Select the appropriate sample plate area, then click **Export.**

     ![Sample Plate contents](image)

     c. Browse to a save location, enter a file name, then click **Save**. The software exports the sample information for the selected load into a *.csv file.

     **Note:** The software exports only the rows required for the selected plate area. The software does not export all 384 rows of the sample plate.

     d. Click **OK** to close the Sample Plate dialog box.

     e. Repeat steps 1 through 4 above for the remaining load(s).

6. Open the new *.csv file, using a spreadsheet or simple text program (such as Microsoft® Excel® Software). The *.csv file should include the column headings and data exported from the software.

7. If needed, edit the sample information in the following columns:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Column description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SampleInfo.SampleID</td>
<td>Identifying information for the sample (user-defined)</td>
</tr>
<tr>
<td>SampleInfo.Description</td>
<td>A description of the sample (user-defined)</td>
</tr>
</tbody>
</table>

**Note:** The software exports several columns. Do not alter the column headings or data for any of the remaining exported columns.
8. (Optional) Add new columns (user-defined) to the right of the exported columns.

9. Save and close the file. Prior to imaging the genotyping plates, you can import the sample information into the OpenArray software, as described in “Import sample information from a *.csv file” on page 71.

Set up the sample plates

About the sample plate

The OpenArray 384-Well Sample Plate is a 384-well microtiter plate. You combine the TaqMan® OpenArray® Genotyping Master Mix and your DNA samples in the sample plate, then use the OpenArray AutoLoader to transfer the mixture from the sample plate to a genotyping plate.

The sample plate is divided into eight areas; each sample plate area is 12 wells × 4 wells (48 wells). During each load, the AutoLoader transfers sample from one area of a single sample plate.

IMPORTANT! The way you set up the sample plates in this section depends on the format of the genotyping plate that you will be transferring your DNA samples to in Chapter 3.
TaqMan® OpenArray® Genotyping Plate formats

There are six TaqMan® OpenArray® Genotyping Plate formats available. As shown in the table below:

- The total number of samples that you can load into the sample plate depends on the TaqMan® OpenArray® Genotyping Plate format.
- A single genotyping plate can accept one to three loads from one to three sample plates, respectively, depending on how many samples per subarray are required.

<table>
<thead>
<tr>
<th>Format</th>
<th>Maximum no. of samples per plate</th>
<th>Required no. of samples per subarray</th>
<th>Required no. of loads</th>
<th>Page number</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>144</td>
<td>3</td>
<td>3</td>
<td>page 35</td>
</tr>
<tr>
<td>32</td>
<td>96</td>
<td>2</td>
<td>2</td>
<td>page 37</td>
</tr>
<tr>
<td>64</td>
<td>48</td>
<td>1</td>
<td>1</td>
<td>page 39</td>
</tr>
<tr>
<td>128</td>
<td>24</td>
<td>1</td>
<td>1</td>
<td>page 40</td>
</tr>
<tr>
<td>192</td>
<td>16</td>
<td>1</td>
<td>1</td>
<td>page 41</td>
</tr>
<tr>
<td>256</td>
<td>12</td>
<td>1</td>
<td>1</td>
<td>page 42</td>
</tr>
</tbody>
</table>
Format 16

Format 16 of the genotyping plate is preloaded with 16 assays. You can load up to 144 samples into Format 16. To properly load Format 16:

- Set up three sample plates.
- When transferring the samples with the AutoLoader (page 54), perform three separate loads. The AutoLoader transfers the sample from one 12-well × 4-well area on three separate sample plates.

Set up three sample plates

1. Label three sample plates with a unique identifier.
   
   *Note:* You enter this identifier when you set up the project file (*.nix) in the OpenArray® SNP Genotyping Analysis Software. See “Set up the software” on page 66.

2. Determine how to arrange the samples in each sample plate. If needed, you can mark the sample plates with a fine-tip marker.

**IMPORTANT!** Be sure to track where the samples are in each sample plate. For each sample plate, Applied Biosystems recommends creating a sample information file (*.csv). See page 25.

Applied Biosystems recommends the following arrangement:

- For sample plate 1, load samples 1 to 48 in one area of the sample plate.
- For sample plate 2, load samples 49 to 96 in one area of the sample plate.
- For sample plate 3, load samples 97 to 144 in one area of the sample plate.

For example:
Subarray locations

When you transfer the samples from the sample plates to Format 16, program the AutoLoader to perform three loads. The AutoLoader transfers the samples to the following locations in each subarray of the genotyping plate:

<table>
<thead>
<tr>
<th>Sample plate</th>
<th>Load</th>
<th>Genotyping plate subarray locations†</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Through-holes A1 through B8</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Through-holes D1 through E8</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Through-holes G1 through H8</td>
</tr>
</tbody>
</table>

† Rows C and F in each subarray will be empty.
Format 32

Format 32 of the genotyping plate is preloaded with 32 assays. You can load up to 96 samples into Format 32. To properly load Format 32:

- Set up two sample plates.
- When transferring the samples with the AutoLoader (page 54), perform two separate loads. The AutoLoader transfers the sample from one 12-well × 4-well area on two separate sample plates.

Set up two sample plates

1. Label two sample plates with a unique identifier.
   
   Note: You enter this identifier when you set up the project file (*.nix) in the OpenArray software. See “Set up the software” on page 66.

2. Determine how to arrange the samples in each sample plate. If needed, you can mark the sample plates with a fine-tip marker.

   Note: Be sure to track where the samples are in each sample plate. For each sample plate, Applied Biosystems recommends creating a sample information file (*.csv). See page 25.

   Applied Biosystems recommends the following arrangement:
   - For sample plate 1, load samples 1 to 48 in one area of the sample plate.
   - For sample plate 2, load samples 49 to 96 in one area of the sample plate.

   For example:
Subarray locations

When you transfer the samples from the sample plates to Format 32, program the AutoLoader to perform two loads. The AutoLoader transfers the samples to the following locations in each subarray of the genotyping plate:

<table>
<thead>
<tr>
<th>Sample plate</th>
<th>Load</th>
<th>Genotyping plate subarray locations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Through-holes A1 through D8</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Through-holes E1 through H8</td>
</tr>
</tbody>
</table>
**Format 64**

Format 64 of the genotyping plate is preloaded with 64 assays. You can load up to 48 samples into Format 64. To properly load Format 64:

- Set up one sample plate.
- When transferring the samples with the AutoLoader (page 54), perform one load. The AutoLoader transfers the sample from one 12-well × 4-well area on one sample plate.

**Set up one sample plate**

1. Label one sample plate with a unique identifier.
   
   **Note:** You enter this identifier when you set up the project file (*.nix) in the OpenArray software. (See “Set up the software” on page 66.)

2. Determine how to arrange the samples in the sample plate. If needed, you can mark the sample plate with a fine-tip marker.

   **IMPORTANT!** Be sure to track where the samples are in the sample plate. Applied Biosystems recommends creating a sample information file (*.csv). See page 25.

   Applied Biosystems recommends that you load samples 1 to 48 in one area of the sample plate. For example:

   ![Subarray locations](image)

   When you transfer the samples from the sample plate to Format 64, program the AutoLoader to perform one load. The AutoLoader transfers the samples to the following locations in each subarray of the genotyping plate:

<table>
<thead>
<tr>
<th>Sample plate</th>
<th>Load</th>
<th>Genotyping plate subarray locations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Through-holes A1 through H8</td>
</tr>
</tbody>
</table>
Format 128

Format 128 of the genotyping plate is preloaded with 128 assays. You can load up to 24 samples into Format 128. To properly load Format 128:

- Set up one sample plate.
- When transferring the samples with the AutoLoader (page 54), perform one load. The AutoLoader transfers the sample from one 12-well × 4-well area on one sample plate.

Set up one sample plate

1. Label one sample plate with a unique identifier.
   Note: You enter this identifier when you set up the project file (*.nix) in the OpenArray software. See “Set up the software” on page 66.

2. Determine how to arrange the samples in the sample plate. If needed, you can mark the sample plate with a fine-tip marker.

   IMPORTANT! Be sure to track where the samples are in the sample plate. Applied Biosystems recommends creating a sample information file (*.csv). See page 25.

Applied Biosystems recommends that you load samples 1 to 24 in one area of the sample plate, in duplicate. For example:

**Subarray locations**

When you transfer the samples from the sample plate to Format 128, program the AutoLoader to perform one load. The AutoLoader transfers the samples to the following locations in each subarray of the genotyping plate:

<table>
<thead>
<tr>
<th>Sample plate</th>
<th>Load</th>
<th>Genotyping plate subarray locations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Through-holes A1 through H8</td>
</tr>
</tbody>
</table>
Chapter 2  Prepare the OpenArray® 384-Well Sample Plates

Set up the sample plates

Format 192

Format 192 of the genotyping plate is preloaded with 192 assays. You can load up to 16 samples into Format 192. To properly load Format 192:

- Set up one sample plate.
- When transferring the samples with the AutoLoader (page 54), perform one load. The AutoLoader transfers the sample from one 12-well × 4-well area on one sample plate.

Set up one sample plate

1. Label one sample plate with a unique identifier.
   Note: You enter this identifier when you set up the project file (*.nix) in the OpenArray software. See “Set up the software” on page 66.

2. Determine how to arrange the samples in the sample plate. If needed, you can mark the sample plate with a fine-tip marker.

   IMPORTANT! Be sure to track where the samples are in the sample plate. Applied Biosystems recommends creating a sample information file (*.csv). See page 25.

   Applied Biosystems recommends that you load samples 1 to 16 in one area of the sample plate, in triplicate. For example:

Subarray locations

When you transfer the samples from the sample plate to Format 192, program the AutoLoader to perform one load. The AutoLoader transfers the samples to the following locations in each subarray of the genotyping plate:

<table>
<thead>
<tr>
<th>Sample plate</th>
<th>Load</th>
<th>Genotyping plate subarray locations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Through-holes A1 through H8</td>
</tr>
</tbody>
</table>
Format 256

Format 256 of the genotyping plate is preloaded with 256 assays. You can load up to 12 samples into Format 256. To properly load Format 256:

- Set up one sample plate.
- When transferring the samples with the AutoLoader (page 54), perform one load. The AutoLoader transfers the sample from one 12-well × 4-well area on one sample plate.

Set up one sample plate

1. Label one sample plate with a unique identifier.
   Note: You enter this identifier when you set up the project file (*.nix) in the OpenArray software. See “Set up the software” on page 66.

2. Determine how to arrange the samples in the sample plate. If needed, you can mark the sample plate with a fine-tip marker.

   **IMPORTANT!** Be sure to track where the samples are in the sample plate. Applied Biosystems recommends creating a sample information file (*.csv). See page 25.

Applied Biosystems recommends that you load samples 1 to 12 in one area of the sample plate, in quadruplicate. For example:

Subarray locations

When you transfer the samples from the sample plate to Format 256, program the AutoLoader to perform one load. The AutoLoader transfers the samples to the following locations in each subarray of the genotyping plate:

<table>
<thead>
<tr>
<th>Sample plate</th>
<th>Load</th>
<th>Genotyping plate subarray locations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Through-holes A1 through H8</td>
</tr>
</tbody>
</table>
Load DNA samples and master mix into the sample plate(s)

1. At room temperature, thaw the DNA samples. Mix the DNA samples by vortexing, then spin for 1 minute @ 1000 rpm.

2. Review the concentration of the normalized genomic DNA samples.
   The recommended starting concentration for human DNA samples is 50 ng/μL. See Appendix C, “DNA Calculator” on page 123.

3. Mix the TaqMan® OpenArray® Genotyping Master Mix by gently inverting the tube 10 times.

4. Add the master mix and the normalized DNA samples to the OpenArray 384-Well Sample Plate. For human DNA samples, use the amounts listed below per well of the sample plate.

   IMPORTANT! As noted in the table below, the component amounts vary, depending on the format of the genotyping plate that you will later transfer to the samples to.

<table>
<thead>
<tr>
<th>Component</th>
<th>Format 16</th>
<th>Format 32</th>
<th>All other formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalized human DNA sample</td>
<td>1.5</td>
<td>2.0</td>
<td>2.5</td>
</tr>
<tr>
<td>Starting concentration = 50 ng/μL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® OpenArray® Genotyping Master Mix, 2X</td>
<td>1.5</td>
<td>2.0</td>
<td>2.5</td>
</tr>
<tr>
<td>Total volume</td>
<td>3.0</td>
<td>4.0</td>
<td>5.0</td>
</tr>
</tbody>
</table>

† One well of a sample plate corresponds to one subarray of a TaqMan OpenArray Genotyping Plate.

5. Mix well by gently pipetting up and down.

6. Cover the sample plate with sealing tape.

7. Spin the sample plate for 1 minute @ 1000 rpm to eliminate bubbles.

Proceed to Chapter 3, “Prepare the TaqMan® OpenArray® Genotyping Plates” on page 45.

Note: If needed, you can store the sealed sample plates. See page 44.
(Optional) Store sealed sample plates

You can prepare multiple sample plates, then store them until needed.

Storing sealed sample plates

After you load the OpenArray 384-Well Sample Plates with DNA samples and master mix (page 43), you can store the sealed sample plates at 4 °C for up to 24 hours.

Using stored sample plates

To use a sample plate that has been stored per the above conditions:

1. Thaw the sample plate at room temperature.

2. Before removing the sealing tape, spin the sample plate for 1 minute @ 1000 rpm.

Proceed to Chapter 3, “Prepare the TaqMan® OpenArray® Genotyping Plates” on page 45.
Prepare the TaqMan® OpenArray® Genotyping Plates

This chapter covers:

- Required materials .......................................................... 46
- Storage conditions ............................................................. 48
- Prepare for loading............................................................. 49
- Place a TaqMan® OpenArray® Genotyping Plate in a plate holder .......... 50
- Load the OpenArray® AutoLoader Tip Blocks .......................... 52
- Run the OpenArray® AutoLoader ......................................... 54
- Seal the TaqMan® OpenArray® Genotyping Case ......................... 58
- Perform thermal cycling ...................................................... 61
- Guidelines for high-throughput loading .................................... 62

In this chapter, you use the OpenArray® AutoLoader to transfer your DNA samples from the OpenArray® 384-Well Sample Plates (prepared in Chapter 2) to TaqMan® OpenArray® Genotyping Plates.

Chapter 3, Prepare the TaqMan® OpenArray® Genotyping Plates

1. Prepare for loading.
2. Place a TaqMan® OpenArray® Genotyping Plate in an OpenArray® AutoLoader Plate Holder.
3. Load the OpenArray® AutoLoader Tip Blocks.
4. Run the OpenArray® AutoLoader.
5. Seal the TaqMan® OpenArray® Genotyping Case.
6. Perform thermal cycling.
Required materials

**TaqMan® OpenArray® Genotyping Plates**

The following table provides a list of available formats for the TaqMan® OpenArray® Genotyping Plates.

<table>
<thead>
<tr>
<th>TaqMan® OpenArray® Genotyping Plate</th>
<th>Part number</th>
<th>Number of assays</th>
<th>Maximum no. of samples per OpenArray sample plate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format 16</td>
<td>4413546</td>
<td>16</td>
<td>144</td>
</tr>
<tr>
<td>32</td>
<td>4413548</td>
<td>32</td>
<td>96</td>
</tr>
<tr>
<td>64</td>
<td>4413550</td>
<td>64</td>
<td>48</td>
</tr>
<tr>
<td>128</td>
<td>4413551</td>
<td>128</td>
<td>24</td>
</tr>
<tr>
<td>192</td>
<td>4413553</td>
<td>192</td>
<td>16</td>
</tr>
<tr>
<td>256</td>
<td>4413554</td>
<td>256</td>
<td>12</td>
</tr>
</tbody>
</table>

**Ordering the TaqMan® OpenArray® Genotyping Plates**

For information on ordering the TaqMan® OpenArray® Genotyping Plates:

1. Go to [www.appliedbiosystems.com](http://www.appliedbiosystems.com).
2. Click the link for TaqMan® SNP Genotyping Assays.
3. Click the link for TaqMan® OpenArray® Genotyping Plates.
4. Click the Ordering Information tab.
## Other consumables and equipment

<table>
<thead>
<tr>
<th>Product</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For loading the TaqMan® OpenArray® Genotyping Plates</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpenArray® Plate Guide Set</td>
<td>Applied Biosystems</td>
<td>20292</td>
</tr>
<tr>
<td>OpenArray® AutoLoader Tip Block</td>
<td>Applied Biosystems</td>
<td>20322</td>
</tr>
<tr>
<td>Finnpipette Multichannel Digital Pipettor, 5 to 50 μL</td>
<td>Applied Biosystems</td>
<td>4452470</td>
</tr>
<tr>
<td>OpenArray® Loader Tips</td>
<td>Applied Biosystems</td>
<td>4404571</td>
</tr>
<tr>
<td>OpenArray® Loader Tips 10 Pack</td>
<td>Applied Biosystems</td>
<td>4404604</td>
</tr>
<tr>
<td>OpenArray® AutoLoader Plate Holder</td>
<td>Applied Biosystems</td>
<td>20384</td>
</tr>
<tr>
<td>OpenArray® AutoLoader</td>
<td>Applied Biosystems</td>
<td>4409360</td>
</tr>
<tr>
<td><strong>For sealing the TaqMan® OpenArray® Genotyping Plates</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TaqMan® OpenArray® Genotyping Accessories Kit</td>
<td>Applied Biosystems</td>
<td>4404572</td>
</tr>
<tr>
<td>The accessories kit contains:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• TaqMan® OpenArray® Genotyping Case</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• OpenArray® Sealing Glue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• OpenArray® Immersion Fluid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpenArray® Case Sealing Station</td>
<td>Applied Biosystems</td>
<td>4409361</td>
</tr>
<tr>
<td>Ethanol†</td>
<td>Major Laboratory Suppliers (MLS)</td>
<td>----</td>
</tr>
<tr>
<td>Razor blade</td>
<td>MLS</td>
<td>----</td>
</tr>
<tr>
<td>25 Slide Holder</td>
<td>Applied Biosystems</td>
<td>4407056</td>
</tr>
<tr>
<td><strong>For thermal cycling the genotyping plates, use one of the following thermal cyclers, which have been qualified for use with the genotyping plates:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Dual Flat Block GeneAmp® PCR System 9700</td>
<td>Applied Biosystems</td>
<td>4428234</td>
</tr>
<tr>
<td>• Bio-Rad® thermal cycler with Slide Chambers Dual Block Alpha Unit</td>
<td>Contact your Applied biosystems service representative for more information on the thermal cyclers.</td>
<td></td>
</tr>
<tr>
<td>• Thermo Electron PX2 thermal cycler</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>For general use</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Powder-free nitrile gloves</td>
<td>MLS</td>
<td>----</td>
</tr>
<tr>
<td>Laboratory-grade wipes</td>
<td>MLS</td>
<td>----</td>
</tr>
<tr>
<td>Forceps</td>
<td>MLS</td>
<td>----</td>
</tr>
<tr>
<td>3 Plastic bins (medium to large) for washing the tip blocks and plate holders</td>
<td>MLS</td>
<td>----</td>
</tr>
</tbody>
</table>
Chapter 3  Prepare the TaqMan® OpenArray® Genotyping Plates

Storage conditions

The following materials require special storage conditions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Storage Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® OpenArray® Genotyping Plate</td>
<td></td>
</tr>
<tr>
<td>If the TaqMan® OpenArray® Genotyping Plate is...</td>
<td>Store at -20 °C until the expiration date provided on the product label.</td>
</tr>
<tr>
<td>Frozen, unopened</td>
<td>Store at room temperature for up to 24 hours.</td>
</tr>
<tr>
<td>Thawed, unopened</td>
<td>Store at room temperature for up to 1 hour.</td>
</tr>
<tr>
<td>Thawed, opened</td>
<td>Store at room temperature, in the dark, for up to 72 hours.</td>
</tr>
<tr>
<td>Loaded and sealed, pre-thermal cycling</td>
<td>Store at 4 °C, in the dark, for up to 72 hours.</td>
</tr>
<tr>
<td>Loaded and sealed, post-thermal cycling</td>
<td>See the product label for storage conditions and expiration date. After you open the package, do not store any remaining immersion fluid; use the amount required, then discard the remainder.</td>
</tr>
<tr>
<td>OpenArray® Immersion Fluid</td>
<td>Store the glue in a dark place; ambient light can cure the glue in the tip. If the glue has been open more than 2 weeks, discard it and use a new tube.</td>
</tr>
<tr>
<td>OpenArray® Loader Tips</td>
<td>Store the glue in a dark place; ambient light can cure the glue in the tip. If the glue has been open more than 2 weeks, discard it and use a new tube.</td>
</tr>
<tr>
<td>OpenArray® Sealing Glue</td>
<td>Store the glue in a dark place; ambient light can cure the glue in the tip. If the glue has been open more than 2 weeks, discard it and use a new tube.</td>
</tr>
</tbody>
</table>
Prepare for loading

1. Be sure that the OpenArray® Plate Guide Set, OpenArray® AutoLoader Tip Blocks, and OpenArray® AutoLoader Plate Holder are completely clean and dry. For cleaning procedures, see “OpenArray® AutoLoader and accessories” on page 112.

   IMPORTANT! Residual water prevents correct loading of the samples into the TaqMan OpenArray plates.

2. Fill the appropriate number of TaqMan® OpenArray® Genotyping Cases with OpenArray® Immersion Fluid:
   a. Using scissors, open a container of immersion fluid.
   b. Place the case in the case rack and fill it approximately 2/3 of the way with immersion fluid.

   IMPORTANT! Within 1 hour after opening the container of immersion fluid, fill the case with immersion fluid, insert a loaded genotyping plate, then seal the case.

3. Remove the genotyping plates from the freezer, but do not open the packaging. Allow the genotyping plates to thaw at room temperature (approximately 5 minutes).

   Note: Unopened genotyping plates can remain at room temperature for up to 24 hours.

   IMPORTANT! Thaw only the genotyping plates you will need for the current loading session.

Proceed immediately to “Place a TaqMan® OpenArray® Genotyping Plate in a plate holder” on page 50.
Place a TaqMan® OpenArray® Genotyping Plate in a plate holder

Important guidelines for handling the plate

- Wear gloves that are one size smaller than the size you typically wear, to help prevent excess glove material from contacting the genotyping plate while loading.
- Hold the genotyping plate by the edges, at the end opposite from the barcode. Do not touch the through-holes.
- Within 1 hour after opening the plate packaging, load the genotyping plate with sample, place the loaded plate in a TaqMan OpenArray Genotyping Case, then seal the case.
- If you drop a loaded genotyping plate, discard it in the appropriate waste container.

Place the plate in the plate holder

1. Remove a thawed genotyping plate from its packaging.
   Note: You may want to save the genotyping plate packaging, as you can scan the barcode on the package to enter the genotyping plate serial number into the software. See “Enter the TaqMan® OpenArray® Genotyping Plate serial number" on page 67.

2. Orient the OpenArray® AutoLoader Plate Holder so that the latch is towards you.

3. Orient the genotyping plate so that the barcode faces up and to your left.
4. Pull the latch on the plate holder towards you, as shown below. The genotyping plate drops into place. Be sure that the genotyping plate reaches all the way to the right of the plate holder, then release the latch.

5. With clean tweezers, push the genotyping plate flat. Push the tweezers against all four corners and the edges, carefully avoiding the through-holes. The numbered side of the genotyping plate should be level with the plate holder.

Proceed immediately to “Load the OpenArray® AutoLoader Tip Blocks” on page 52.
Load the OpenArray® AutoLoader Tip Blocks

1. Using tweezers, peel the sealing tape from the area of the sample plate that contains the samples to be transferred.

2. From the OpenArray® Plate Guide Set, select the plate guide that aligns with the 12-well x 4-well areas in the sample plate:
   - One plate guide is for sample plate areas 1, 3, 6, and 8 (shown below).
   - One plate guide is for sample plate areas 2, 4, 5, and 7.

3. Place the plate guide over the sample plate.

   **IMPORTANT!** Be sure that the plate guide sits flat on the benchtop. The plate guide should not be tilted by the sample plate beneath it. To check the plate guide position, gently slide the plate guide across the benchtop. If the plate guide is not aligned correctly, it slips toward the base of the sample plate.

4. Place the tip block into the appropriate area of the plate guide.
   For example, place the tip block in position 1 to load the tips with samples from sample plate area 1. Sample plate area 1 includes wells A1 to A12, B1 to B12, C1 to C12, and D1 to D12. For an illustration of the sample plate areas, refer to “Set up the sample plates” on page 33.
Chapter 3  Prepare the TaqMan® OpenArray® Genotyping Plates

Load the OpenArray® AutoLoader Tip Blocks

5. Using the Finnpipette Multichannel Digital Pipettor (or by hand), place 12 OpenArray® Loader Tips in each hole of the tip block (one row). Release the tips when they are submerged.

IMPORTANT! Do not press firmly when inserting the tips into the tip block. Let the tips drop into the tip block slots.

6. Slide the tip block up and down (25 to 50 times), until the tips:
   • Are filled to 1 mm above the bottom edge of the tip block.
   • Have no air bubbles.

You can remove the tip block to look at the tips. When you replace the tip block to load more sample, be sure to:
   • Level the tip heights.
   • Keep the tip block in the same orientation. If you turn the tip block around, the samples will mix together and become contaminated.

IMPORTANT! If the tips are not filled correctly, product performance may be adversely affected.
Chapter 3  Prepare the TaqMan® OpenArray® Genotyping Plates

Run the OpenArray® AutoLoader

7. Leave the tip block with the loaded tips in the plate guide, keeping the tips submerged in sample, until the genotyping plate is ready for loading.

8. If you are transferring samples from additional sample plates (see “Set up the sample plates” on page 33), repeat steps 2 through 7 for each sample plate.

Proceed immediately to “Run the OpenArray® AutoLoader”.

Run the OpenArray® AutoLoader

Use the OpenArray® AutoLoader to load the TaqMan® OpenArray® Genotyping Plates (that is, transfer samples from the sample plate onto genotyping plates).
Set up the AutoLoader

For the following hazards, see the complete safety alert descriptions in Appendix F, “Safety”:

⚠️ **WARNING! PHYSICAL INJURY HAZARD.** Moving parts can crush and cut. Keep hands clear of moving parts while operating the instrument.

1. Power on the AutoLoader. The AutoLoader homes the platform, then displays:
   Welcome, AutoLoader Ready! Press Enter to Start

2. Press ENTER. The screen displays:
   Samples/Subarray:
   ENTER: #
   NEXT: More Choices
   where # is the number of loads the AutoLoader will perform: ONE, TWO, or THREE

3. Press ENTER to accept the current number, or press NEXT until the correct number appears, then press ENTER. Be sure to select the correct number of loads for your genotyping plate:

<table>
<thead>
<tr>
<th>Genotyping plate format</th>
<th>No. of loads</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format 16</td>
<td>THREE</td>
</tr>
<tr>
<td>Format 32</td>
<td>TWO</td>
</tr>
<tr>
<td>Format 64</td>
<td>ONE</td>
</tr>
<tr>
<td>Format 128</td>
<td>ONE</td>
</tr>
<tr>
<td>Format 192</td>
<td>ONE</td>
</tr>
<tr>
<td>Format 256</td>
<td>ONE</td>
</tr>
</tbody>
</table>

Note: If you need to change the number of loads that you entered, press CANCEL, then at the “Continue with the Cancel” prompt, press ENTER.
4. At the prompt, place the genotyping plate and plate holder on the AutoLoader platform. The notch in the plate holder should face the instrument.

5. Gently push the plate holder all the way down.

6. Press ENTER to send the platform to the load position.

7. At the prompt, insert the loaded tip block (from step 7. on page 54):

   IMPORTANT! Insert the loaded tip block only when prompted.

   a. Place the loaded tip block above the genotyping plate.
   b. Align the tip block with the metal guide pins on the AutoLoader.
   c. Bring the tip block straight down, without tilting it. Slowly position the tip block over the metal guide pins.

   IMPORTANT! Perform this step slowly and evenly to prevent improper sample loading (for example, too much sample or not enough sample).

8. Be sure the tip heights are level:

   a. Gently slide your finger across the tops of the tips so that the tip heights are level.

   Or

   b. Gently rest another tip block on top of the tips until the tip heights are level, then remove the tip block.

   IMPORTANT! For the AutoLoader to properly load the genotyping plate with sample, the tip heights must be level.
Load the sample

IMPORTANT! After you press ENTER (step 1. below), you cannot stop the AutoLoader. If you want to stop the AutoLoader before you begin loading sample, press STOP now. The AutoLoader ends the current operation, calibrates, then returns to the Welcome screen. If you are prompted to remove the tip block, you must remove the tip block to proceed.

1. On the AutoLoader, press ENTER. The samples in each tip are loaded in the appropriate through-holes.

2. At the prompt, remove the tip block:
   a. Slowly pull the tip block straight up, without any rocking motion. To prevent rocking, it may be helpful to hold the tip block with your index finger and thumb, and press your remaining fingers against the AutoLoader surface.
      Note: To ensure that the samples are uniformly loaded in the genotyping plate, remove the tip block slowly and evenly.
   b. Press ENTER.
      Note: If you programmed the AutoLoader to perform two or three loads, you are prompted to remove the current tip block and insert the next tip block. Remove the tip block following the steps above; insert the next tip block per the steps in “Set up the AutoLoader” on page 55.

3. Follow the prompts to remove the plate holder from the AutoLoader platform.

4. Remove the genotyping plate from the plate holder:
   - Place the plate holder on a flat surface.
   - Push the latch down, then carefully lift the genotyping plate from the plate holder with one hand.
   - With the other hand, grasp the edge of the genotyping plate and lift it out.

IMPORTANT! Hold the genotyping plate by the edges, at the end opposite from the barcode. Do not touch the through-holes. If you drop a loaded genotyping plate, discard it in the appropriate waste container.

To prevent evaporation of the samples, proceed immediately to “Seal the TaqMan® OpenArray® Genotyping Case” on page 58.
Chapter 3  Prepare the TaqMan® OpenArray® Genotyping Plates

Seal the TaqMan® OpenArray® Genotyping Case

Insert the loaded plate into a TaqMan® OpenArray® Genotyping Case

1. Hold the genotyping plate by its edges, at the end opposite from the barcode, with the barcode facing up.

   **IMPORTANT!** Do not touch the through-holes. If you drop a loaded genotyping plate, discard it in the appropriate waste container.

2. Slide the genotyping plate into a TaqMan OpenArray Genotyping Case. Be sure that the:
   - Plate aligns with the grooves in the case. Misalignment may cause surface rubbing, loss of samples, and/or contamination.
   - Genotyping plate barcode is at the top of the case and facing the black, painted side of the case.
   - Push the genotyping plate all the way down into the case. Use tweezers if needed.
   - If needed, adjust the level of immersion fluid with a pipette. The immersion fluid should be level with the genotyping plate.
   - Discard leftover immersion fluid in an appropriate waste container.

Seal the TaqMan® OpenArray® Genotyping Case

Use the OpenArray® Sealing Glue and the OpenArray® Case Sealing Station to seal the TaqMan OpenArray Genotyping Case so that immersion fluid does not leak during thermal cycling or imaging.

**IMPORTANT!** If the glue has been open more than 2 weeks, discard it and use a new tube. Store the glue in a dark place; ambient light can cure the glue in the tip.
For the following hazards, see the complete safety alert descriptions in Appendix F, “Safety”:

**WARNING! ULTRAVIOLET LIGHT HAZARD.**

1. Fill the case with glue:
   a. Place a drop of glue on one edge of the case opening, then fill until the glue reaches the top of the case. Angle the tip so that the glue reaches the inside rail.

   ![Image of glue being applied to one edge of the case]

   b. Repeat step 1.a. on the other edge of the case opening.

   ![Image of glue being applied to the other edge of the case]

   c. Continue adding glue on each side until the glue runs together in the middle. Fill the case to the top. Be sure that both the left and right sides are covered with glue.

   ![Image of glue covering the sides of the case]

2. If you see air bubbles in the immersion fluid underneath the glue, use a small pipette to carefully aspirate the bubbles.

3. With a lint-free wipe, wipe any excess glue from the surface of the glass.
4. Cure the glue:
   a. Place the case(s) in the sealing station so that the barcode faces out, then close the door. You can place up to two cases at a time in the sealing station.
   b. Turn the switch to ON and allow the glue to cure for 90 seconds.
   c. Turn the switch to OFF, then remove the cases.

Clean the TaqMan® OpenArray® Genotyping Case

IMPORTANT! Be sure to clean each TaqMan OpenArray Genotyping Case thoroughly. Dust, glue, or excess sample on the case may interfere with thermal uniformity and can fluoresce. While cleaning, do not squeeze the case; gently hold the case to ensure the glass does not touch the genotyping plate through-holes.

For the following hazards, see the complete safety alert descriptions in Appendix F, “Safety”:

1. If there is any glue on a case, carefully remove the glue with a razor blade. Be sure not to scratch the glass.

2. Moisten a lint-free wipe with ethanol, then gently wipe the case surface.

3. Allow the case to air-dry, or spray each side of the case with compressed air for 2 seconds.

Proceed to “Complete loading for the remaining plates” on page 61.

Note: After the loaded genotyping plate is sealed, you can store it at room temperature, in the dark, for up to 72 hours.
Complete loading for the remaining plates

Before you begin thermal cycling, repeat the following procedures to load the remaining genotyping plates:

- “Prepare for loading” on page 49
- “Place a TaqMan® OpenArray® Genotyping Plate in a plate holder” on page 50
- “Load the OpenArray® AutoLoader Tip Blocks” on page 52
- “Run the OpenArray® AutoLoader” on page 54
- “Seal the TaqMan® OpenArray® Genotyping Case” on page 58

Proceed to “Perform thermal cycling” (this page).

Perform thermal cycling

Qualified thermal cyclers

You must perform thermal cycling on a thermal cycler that has been qualified for use with the genotyping plates. As part of the qualification process, the thermal cycler must be programmed with a thermal cycling protocol that is appropriate for the genotyping plates.

When your OpenArray® platform is installed, the Applied Biosystems service representative also installs the thermal cycling protocol on your qualified thermal cycler.

The following thermal cyclers are qualified for use with the TaqMan Open Array plates:

- **Dual Flat Block GeneAmp® PCR System 9700** – The Dual Flat Block GeneAmp® PCR System 9700 has been developed and validated for efficient and accurate thermal cycling of the genotyping plates. The Dual Flat Block sample module can cycle up to eight genotyping plates simultaneously. For the thermal cycling protocol, refer to the **Dual Flat Block GeneAmp® PCR System 9700 User Guide**.
- **Bio-Rad® thermal cycler with Slide Chambers Dual Block Alpha Unit** – For the thermal cycling protocol, see “Bio-Rad® thermal cycler protocol” on page 127.
- **Thermo Electron PX2 thermal cycler** – For the thermal cycling protocol, see “Thermo Electron PX2 thermal cycler protocol” on page 129.

Note: Contact your Applied Biosystems service representative for more information on the thermal cyclers.

Storage

After thermal cycling, the genotyping plates can be stored at 4 °C, in the dark, for up to 72 hours.
Guidelines for high-throughput loading

For optimal efficiency when loading large numbers (>6) of genotyping plates, follow the guidelines below.

Before you begin loading

- If possible, obtain a tip block for each genotyping plate you will load during the high-throughput loading session.
- Be sure that all the tip blocks are clean and dry, then stack the tip blocks next to the AutoLoader. For cleaning procedures, see “OpenArray® AutoLoader and accessories” on page 112.
- Fill all TaqMan OpenArray Genotyping Cases with immersion fluid, then place the cases in a vertical slide rack.
- Insert all of the genotyping plates into plate holders, then stack the plate holders to one side.
- Load the tip blocks with DNA samples. Be sure that the tips are filled to 1 mm above the bottom edge of the tip block and that there are no air bubbles.

During and after loading

- To help avoid mistakes when entering sample information (page 68), run the genotyping plates in the AutoLoader in alphanumeric order (per the genotyping plate serial number).
- Seal the TaqMan OpenArray Genotyping Cases as time permits. You can:
  - Seal all the cases at once, after the loading session is completed.
  - Seal the cases in batches, while other genotyping plates are being loaded.

**IMPORTANT!** To avoid evaporation, you must insert the genotyping plate into a case and cover it with immersion fluid immediately after loading. However, the cases can be left unsealed for up to 8 hours.

- Use a carrying case to transport several loaded genotyping plates from the case sealing station to the thermal cycler, and from the thermal cycler to the OpenArray® instrument.
- After loading is complete, you can use a large bin to clean several tip blocks at a time. For cleaning procedures, see “OpenArray® AutoLoader and accessories” on page 112.
This chapter covers:

- About the data files ................................................. 64
- Set up the software .................................................. 66
- Enter sample information .......................................... 68
- Perform imaging ...................................................... 80

In this chapter, you set up the OpenArray® SNP Genotyping Analysis Software to prepare for imaging, then perform an imaging run on the loaded TaqMan® OpenArray® Genotyping Plates.

1. Set up the OpenArray® SNP Genotyping Analysis Software.
2. Enter sample information in the OpenArray software.
3. Place the loaded TaqMan® OpenArray® Genotyping Plates in the OpenArray® instrument, then perform an imaging run.
About the data files

The OpenArray® SNP Genotyping Analysis Software uses four types of data files:

- TaqMan® OpenArray® Genotyping Plate setup files (*.spf) (this page)
- Project files (*.nix) (this page)
- TaqMan® OpenArray® Genotyping Plate data files (*.spd) (page 65)
- Sample information files (*.csv) (page 65)

TaqMan® OpenArray® Genotyping Plate setup files (*.spf)

When you order one or more TaqMan® OpenArray® Genotyping Plates, a CD is shipped with your order. The CD includes one plate setup file (*.spf) for each genotyping plate in your order. Each plate setup file contains information for its corresponding genotyping plate, such as:

- Assay ID
- Reporter 1 and 2 sequences
- Gene symbol and name
- Location of each assay in the genotyping plate

Note: The OpenArray software uses the *.spf file to populate the columns in the Assays pane. For more information, see “View data in the Assays pane” on page 83.

Each plate setup file is named with the serial number of its corresponding genotyping plate. For example, the plate setup file for a genotyping plate with the serial number ABC01 is named:

- ABC01.spf

You must copy the plate setup files (*.spf) to your computer (page 66). Before the OpenArray® instrument can image a genotyping plate, the OpenArray software must access the plate’s corresponding *.spf file.

Project files (*.nix)

Project files (*.nix) are the files you view and modify in the OpenArray software. A project file allows you to combine, edit, and save changes to run data from up to 50 plate data files (*.spd).

Project files contain:

- **Run data** – When you image genotyping plates, the run data is automatically saved to a plate data file (*.spd), then copied to the currently open project file (*.nix).
- **Modifications made to the data** – Within a single project file, you can overlay, view, and edit cluster plots from multiple plate data files (as described in Chapter 5).
To save modifications made to the data, you must save the project file (use the File ▶ Save or File ▶ Save As function). Otherwise, all your changes are lost. Project file names and save locations are user-defined.

IMPORTANT! The software copies the run data from the plate data file to the project file. The files are not linked; that is, modifications you save to the project file (*.nix) are not saved to the corresponding plate data file (*.spd).

**TaqMan® OpenArray® Genotyping Plate data files (*.spd)**

A plate data file (*.spd) contains run data for a single genotyping plate. Plate data files are generated by the OpenArray software during imaging.

The software automatically names plate data files with the genotyping plate serial number. For example, the plate data file for a genotyping plate with the serial number ABC01 is named:

- ABC01.spd

By default, the software saves the *.spd files to the following location:

`<drive>\images\<run date><run number>`

where:

- `<drive>` is the computer drive on which the OpenArray software is installed. The default installation drive is the C: drive.
- `<run date>` is the date the run was performed.
- `<run number>` is the chronological run number.

For example, data for the third run on June 15, 2008, is saved to:

- C:\images\06-15-08\3

After a run is completed, you can change the *.spd file name and or save the *.spd file to a different location.

**Sample information files (*.csv)**

The OpenArray software uses comma-delimited files (*.csv) to import and export sample information:

- **Import** – Applied Biosystems recommends that you create sample information files (*.csv) to track your DNA samples, per the procedures on page 25. Prior to imaging the genotyping plates, you can import the sample information into the OpenArray software. See “Import sample information from a *.csv file” on page 71.

- **Export** – After an imaging run, you can export data from your project. See “Export *.csv files” on page 106.
Set up the software

Set up the OpenArray software for each genotyping plate to be included in the imaging run:

• Start the OpenArray® instrument and software (this page)
• Copy the plate setup file (*.spf) to your computer (this page)
• Enter the TaqMan® OpenArray® Genotyping Plate serial number (page 67)
• Enter sample information (page 68)

Start the OpenArray® instrument and software

1. Power on the OpenArray® instrument. The power switch is on the front-right of the instrument.

2. On the computer, start the OpenArray software:
   • Double-click the software icon.
   or
   • Select Start > All Programs > BioTrove > OpenArray® SNP Genotyping Analysis Software <version number> > OpenArray® SNP Genotyping Analysis Software.
      The software opens a new (empty) project file (*.nix).

3. Wait for the system to fully boot up. When the system is ready, the system indicator circle turns green and Idle appears in the software status bar (at the bottom of the window). This may take a few minutes.

Copy the plate setup file (*.spf) to your computer

1. Locate the CD that was shipped with your TaqMan Open Array plate.

2. Insert the CD into the computer, then open the folder that contains the plate setup files (*.spf).
   Note: If you ordered more than one genotyping plate, the folder contains a plate setup file for each plate.

3. Copy the plate setup files to the PLATEFILES folder:
   <drive>\Program Files\BioTrove\PLATEFILES
   where <drive> is the computer drive on which the OpenArray software is installed. The default installation drive is the C: drive.
Enter the TaqMan® OpenArray® Genotyping Plate serial number

In this procedure, you enter the serial number for each genotyping plate to be imaged (1 to 3 plates can be imaged per run). The OpenArray software uses the serial numbers to access the appropriate plate setup files (*.spf). During imaging, the software uses information in the plate setup files to populate the Assays pane in the project file (*.nix).

Note: For information on the Assays pane, see “View data in the Assays pane” on page 83.

To enter genotyping plate serial numbers:

1. In the OpenArray software, open a project file (*.nix). You can open:
   - A new project file – Use the project file automatically opened at startup, or select File ➔ New.
   - An existing project file (containing data from previous runs) – Select File ➔ Open, browse to and open a project file.

2. Click Image to open the Input Plate Serial Numbers dialog box:

3. In the Position 1 pane, click Locate File.
   Note: The positions indicate where the genotyping plate will be placed in the OpenArray® instrument (page 79). If you are running fewer than three genotyping plates, Applied Biosystems recommends the following: For one plate, use Position 1; for two plates, use Positions 1 and 2.
4. Browse to and open the plate setup file (*.spf) that corresponds to the genotyping plate. The software automatically displays the serial number in the Plate Serial Number field.

Note: You can also enter the serial number by typing it in or by scanning the barcode located on the genotyping plate package. To enter the serial number by typing or scanning, the *.spf file must be located in the PLATEFILES directory (see “Copy the plate setup file (*.spf) to your computer” on page 66). Otherwise, the software will not be able to automatically locate the *.spf file.

5. Repeat steps 3. and 4. for Positions 2 and 3. If you are loading fewer than three genotyping plates, leave the Plate Serial Number fields for these positions empty.

Enter sample information

In this procedure, you enter information about:

- Each sample plate that was used to transfer DNA samples to the genotyping plates in the current imaging run.
- Each DNA sample that was transferred to the genotyping plate.

This information allows you to track the sample plates, and map the sample plate areas to each genotyping plate.

You can:

- Manually enter sample information (page 69)
- Import sample information from a *.csv file (page 71)
- (Optional) Add columns (page 74)
- (Optional) Delete user-created columns (page 76)
1. In the Position 1 pane of the Input Plate Serial Numbers dialog box, click **Edit** to open the Sample Information dialog box.

   ![Input Plate Serial Numbers](image)

2. For each load number:
   
   a. In the Sample Plate Serial Number field, enter the unique identifier for each sample plate.

      Note: The unique identifier is the one you created when you prepared the sample plates. See “Set up the sample plates” on page 33.

   b. From the Plate Area # dropdown menu, select the 12-well × 4-well area of the sample plate that the samples were transferred from.

   ![Sample Information For Generic_64_1](image)

   ![Sample Information For BJS84](image)

   The software displays 1 to 3 load numbers (Load 1, Load 2, and Load 3), depending on the format of the genotyping plate.
Chapter 4  Perform Imaging

Set up the software

3. Enter sample information for each sample, per the procedure below.
   Note: You cannot enter or edit information in the following columns: Load Number, Plate ID, and Address. If you want to add new columns, see page 74.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then, in the Sample Information dialog box...</th>
</tr>
</thead>
</table>
| Enter sample information for all loads at one time (1 to 3 loads) | Edit the desired fields in the Selected Samples pane:  
1. Double-click inside the field to activate it.  
2. Enter the appropriate information. |
| Enter sample information for each load separately | 1. Click next to appropriate load number to open the Sample Plate dialog box.  
2. Edit the desired fields in the Sample Plate Well Contents pane:  
   a. Double-click inside the field to activate it.  
   b. Enter the appropriate information.  
3. Click OK to close the Sample Plate dialog box.  
4. Repeat steps 1. through 3. above for the remaining load(s). |
4. Click **OK** to close the Sample Information dialog box and return to the Input Plate Serial Numbers dialog box.

5. If you are imaging two or three genotyping plates, repeat step 1. on page 69 through step 4. (above) for the remaining plates. In step 1.:
   - For the second plate, click **Edit** next to Position 2.
   - For the third plate, click **Edit** next to Position 3.

Leave the Input Plate Serial Numbers dialog box open, and proceed to “Perform imaging” on page 78. (If you close the dialog box, the information you have entered will be lost.)

1. If you have not done so already, create a *.csv file per one of the following procedures:
   - “Use a spreadsheet or simple text program” on page 30
   - “Export sample information from an existing *.nix file” on page 30

2. In the Position 1 pane of the Input Plate Serial Numbers dialog box, click **Edit** to open the Sample Information dialog box.
3. For each load number:
   a. In the Sample Plate Serial Number field, enter the unique identifier for each sample plate.
      Note: The unique identifier is the one you created when you prepared the sample plates. See “Set up the sample plates” on page 33.
   b. From the Plate Area # dropdown menu, select the 12-well × 4-well area of the sample plate that the samples were transferred from.
4. Import the sample information, per the procedure below.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then, in the Sample Information dialog box...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import the sample information for all loads at one time (1 to 3 loads)</td>
<td>1. Click <strong>Import</strong> to open the Import Sample Plates dialog box.</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Import Sample Information dialog box" /></td>
</tr>
<tr>
<td></td>
<td>2. Browse to and open the *.csv file to import. The sample information appears in the Selected Samples pane. IMPORTANT! Be sure to select a *.csv file that contains sample information for all of the required loads.</td>
</tr>
<tr>
<td></td>
<td>3. Edit the sample information in each row, as needed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Import the sample information for each load separately</th>
<th>1. Click <strong>next to appropriate load number to open the Sample Plate dialog box.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image2.png" alt="Sample Plate dialog box" /></td>
</tr>
<tr>
<td></td>
<td>2. Click <strong>Import</strong> to open the Import Sample Plates dialog box.</td>
</tr>
<tr>
<td></td>
<td><img src="image3.png" alt="Import Sample Plates dialog box" /></td>
</tr>
<tr>
<td></td>
<td>3. Browse to and open the *.csv file to import. The sample information appears in the Sample Plate Well Contents pane.</td>
</tr>
<tr>
<td></td>
<td>4. Edit the sample information in each row, as needed.</td>
</tr>
<tr>
<td></td>
<td>5. Click <strong>OK</strong> to close the Sample Plate dialog box.</td>
</tr>
<tr>
<td></td>
<td>6. Repeat steps 1. through 5. above for the remaining load[s].</td>
</tr>
</tbody>
</table>
5. Click OK to close the Sample Information dialog box and return to the Input Plate Serial Numbers dialog box.

6. If you are imaging two or three genotyping plates, repeat step 1. on page 71 through 5. (above) for the remaining plates. In step 1.:
   - For the second plate, click Edit next to Position 2.
   - For the third plate, click Edit next to Position 3.

Leave the Input Plate Serial Numbers dialog box open, and proceed to “Perform imaging” on page 78. (If you close the dialog box, the information you have entered will be lost.)

(Optional) Add columns

Note: You can also add new columns after imaging is complete; see “View data in the Assays pane” on page 83.

1. In the Position 1 pane of the Input Plate Serial Numbers dialog box, click Edit to open the Sample Information dialog box.
2. Add new columns, per the procedure below.
   Do not use commas or periods in column names; text is case-sensitive. After imaging, in the Samples pane of the OpenArray software main window, SampleInfo.Properties is prefixed to all new column names to differentiate them from the standard columns. If you assign a standard column name to a new column, the software will automatically rename it. For a description of the standard columns, see page 84.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then, in the Sample Information dialog box...</th>
</tr>
</thead>
</table>
| Add new columns for all loads at one time (1 to 3 loads) | 1. Click **Edit Columns** to open the Columns For Sample Plates dialog box.  
2. Click **Add**, select **New Field**, enter the new column name, then click **OK**. |
| Add new columns for each load separately | 1. Click **next to the appropriate load number to open the Sample Plate dialog box.**  
2. Click **Edit Columns** to open the Columns For Sample Plate dialog box.  
3. Click **Add**, select **New Field**, enter the new column name, then click **OK**.  
4. Click **OK** to close the Sample Plate dialog box.  
5. Repeat steps 1. through 4. above for the remaining load(s). |
3. Click **OK** to close the Sample Information dialog box and return to the Input Plate Serial Numbers dialog box.

4. If you are imaging two or three genotyping plates, repeat step 1. on page 74 through step 3. (above) for the remaining plates. In step 1.:
   - For the second plate, click **Edit** next to Position 2.
   - For the third plate, click **Edit** next to Position 3.

   ![Image of Input Plate Serial Numbers dialog box]

   Leave the Input Plate Serial Numbers dialog box open, and proceed to “Perform imaging” on page 78. (If you close the dialog box, the information you have entered will be lost.)

   **[Optional] Delete user-created columns**

   Note: You cannot delete any columns created by the software (standard columns). For a description of the standard columns, see page 84.

   1. In the Position 1 pane of the Input Plate Serial Numbers dialog box, click **Edit** to open the Sample Information dialog box.
2. Delete user-created columns, per the procedure below.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Then, in the Sample Information dialog box...</th>
</tr>
</thead>
</table>
| Delete columns for all loads at one time (1 to 3 loads) | 1. Click **Edit Columns** to open the Columns For Sample Plate dialog box.  
2. Select the column name, click **Delete**, then click **OK**. |

![Columns For Sample Plates: a dialog box](image)

| Delete columns for each load separately | 1. Click **next** to appropriate load number to open the Sample Plate dialog box.  
2. Click **Edit Columns** to open the Columns For Sample Plate dialog box.  
3. Select the column name, click **Delete**, then click **OK**. |

![Sample Plate dialog box](image)

4. Click **OK** to close the Sample Plate dialog box.  
5. Repeat steps 1. through 4. above for the remaining load[s].

3. Click **OK** to close the Sample Information dialog box and return to the Input Plate Serial Numbers dialog box.
4. If you are imaging two or three genotyping plates, repeat step 1. on page 76 through step 3. (above) for the remaining plates. In step 1.:
   • For the second plate, click **Edit** next to Position 2.
   • For the third plate, click **Edit** next to Position 3.

Leave the Input Plate Serial Numbers dialog box open, and proceed to “Perform imaging” on page 78. (If you close the dialog box, the information you have entered will be lost.)

## Perform imaging

During imaging, the OpenArray® instrument senses and records the amount of fluorescence in each through-hole of the genotyping plates. The run data are automatically saved to the plate data file (*.spd).

**Workflow:**
- Place the plates into the OpenArray® instrument (this page)
- Perform imaging (page 80)

## OpenArray® instrument commands

The table below is a summary of OpenArray software commands that you can use to control the OpenArray® instrument.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop Imaging</td>
<td>To stop imaging at any time:</td>
</tr>
<tr>
<td></td>
<td>In the OpenArray software, select Actions &gt; Stop Imaging. A message appears asking if you want to save the collected data.</td>
</tr>
<tr>
<td></td>
<td>Click Yes to save the incomplete plate data file (*.spd).</td>
</tr>
<tr>
<td></td>
<td>Or Click No to continue imaging.</td>
</tr>
<tr>
<td>Interior Light</td>
<td>To turn on the light inside the instrument, select Actions &gt; Interior Light.</td>
</tr>
</tbody>
</table>
Place the plates into the OpenArray® instrument

1. Open the OpenArray® instrument door and lid, then place the genotyping plate(s) into the instrument.

2. Be sure that:
   - The plate position in the instrument matches the position you entered in the software (see step 3. on page 67):
     - Position 1 is at the back of the instrument
     - Position 2 is in the middle
     - Position 3 is at the front (closest to the door)
   - The barcode is facing up and to the right, and the plate is flush with the right and back edges.

Note: If the plates are not positioned correctly, your data results will be adversely affected.

3. Close the OpenArray® instrument lid and door.
Perform imaging

1. In the Input Plate Serial Numbers dialog box, click **Image**. During the imaging run, note that:
   - On the OpenArray® instrument, a blue indicator light on the front of the instrument is on.
   - In the OpenArray software, the system indicator circle turns blue and **Imaging OpenArrays** appears in the software status bar (at the bottom of the window).

   **IMPORTANT!** Do not open the OpenArray® instrument door during the imaging run. The run is complete when: (1) The blue indicator light on the instrument is off; and (2) In the software, the system indicator circle turns green and data appears.

2. When the run is complete, save the project file (*.nix):
   a. Select File ➤ Save or File ➤ Save As to open a save dialog box.
   b. Browse to a save location, then enter a file name.
      Note: Project file names and save locations are user-defined. Project file names can be up to 255 characters in length, including spaces and non-alphanumeric characters. The following characters are not allowed: \ / : * ? “ <> |.
   c. Click **Save**.

3. Open the instrument door, then remove the genotyping plates.
   Note: Applied Biosystems recommends that you temporarily save the genotyping plates until you have reviewed the data. If you store the plates in the dark at 4 °C, you can re-image the plates for up to 5 days.

4. To image more genotyping plates, open the appropriate project file (*.nix). You can:
   - Use the currently opened project file.
   - Open a new project file – Select File ➤ New.
   - Open an existing project file (containing data from previous runs) – Select File ➤ Open, then browse to and open a project file.

   Note: If needed, you can regroup data later. See “(Optional) Modify project files” on page 102.
This chapter covers:
- View the results. ......................................................... 82
- (Optional) Modify clustering parameters. .......................... 92
- (Optional) Modify project files ..................................... 102
- (Optional) Publish data .................................................. 105
- (Optional) Perform downstream analysis. ......................... 108

In this chapter, you view the data from the imaging run (performed in Chapter 4) in a project file (*.nix). If needed, you can modify the clustering parameters or modify the project file. This chapter also explains how to publish data and how to export data for downstream analysis using the Applied Biosystems AutoCaller™ Software.

---

Chapter 5, Analyze the Run Data

1. View the results.
2. (Optional) Modify clustering parameters.
3. (Optional) Modify project files (*.nix).
4. (Optional) Publish data.
5. (Optional) Perform downstream analysis using the AutoCaller™ Software.
### View the results

After an imaging run, the OpenArray® SNP Genotyping Analysis Software automatically calls the genotypes for each TaqMan® OpenArray® Genotyping Plate in the run. To view the results of the automatic analysis:

- **Open a project file** (this page)
- **View data in the Assays pane** (page 83)
- **View data in the Scatter Plot** (page 85)
- **View data in the Samples pane** (page 88)

If the automatic calls are not suitable for your experiment, see “(Optional) Modify clustering parameters” on page 92.

#### Open a project file

1. In the OpenArray software, select **File** ➔ **Open**, then browse to and open the appropriate project file (*.nix).

   **Note:** After a run, the OpenArray software automatically displays the results for the current run.

2. In the Assays pane, select the assay ID to view. The data appear in the Samples pane and in the Scatter Plot.
3. To view data for a specific through-hole, select the:
   - Datapoint in the Scatter Plot (page 85)
   or
   - Through-hole address in the Samples pane (page 88)
   Through-holes are identified in the Samples pane by an address. The address is assigned based on the through-hole location in the genotyping plate.

4. (Optional) Enter the allele nucleotide sequences detected by each assay:
   a. In the Assays pane, click in the appropriate sequence column: **Reporter 1 Sequence** or **Reporter 2 Sequence**.
   b. Enter the appropriate letter for the reporter dye: **F** (FAM™ dye), **V** (VIC® dye), or **N** (non-specific).

View data in the Assays pane

Each row in the Assays pane represents a specific assay.

1. To select individual assays, click the row you want to view.
   In the Scatter Plot, the software displays a black circle around the datapoints for the assays you selected. (Each datapoint in the Scatter Plot represents a specific through-hole.)

2. To arrange rows in ascending or descending order, click a column heading.
### Assays pane column descriptions

<table>
<thead>
<tr>
<th><strong>Column name</strong></th>
<th><strong>Column description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Study Name</td>
<td>User-defined name for the sales order. At the time of purchase, you enter a study name for your order.</td>
</tr>
<tr>
<td>Order Number</td>
<td>Customer sales order number</td>
</tr>
<tr>
<td>Assay ID</td>
<td>Unique identifier for the assay</td>
</tr>
<tr>
<td>Reporter 1 Sequence</td>
<td>The nucleotide sequence of reporter 1</td>
</tr>
<tr>
<td>Reporter 2 Sequence</td>
<td>The nucleotide sequence of reporter 2</td>
</tr>
<tr>
<td>Gene Symbol</td>
<td>LocusLink symbol for the associated gene</td>
</tr>
<tr>
<td>Gene Name</td>
<td>LocusLink gene name</td>
</tr>
<tr>
<td>Chromosome</td>
<td>Chromosome on which the gene or SNP is found</td>
</tr>
<tr>
<td>NCBI SNP Reference</td>
<td>Reference ID from the NCBI-dbSNP database</td>
</tr>
<tr>
<td>Cytogenetic Band</td>
<td>Chromosomal band location of gene. If the cytogenetic band is not available, the chromosome number is listed instead</td>
</tr>
<tr>
<td>SNP Type</td>
<td>Type of SNP, based on Celera Assembly: Acceptor Splice Site, Donor Splice Site, Intergenic/Unknown, Intron, Mis-sense Mutation, Nonsense Mutation, Putative UTR 5ESilent Mutation, UTR 3′, UTR 5′</td>
</tr>
</tbody>
</table>
View data in the Scatter Plot

Each datapoint in the Scatter Plot represents a specific through-hole.

1. To select:
   - **Individual through-holes** – Click the datapoint you want to view.
   - **Multiple through-holes** – Press the CTRL key while clicking the datapoints you want to view.

   In the Samples pane, the software highlights the rows for the through-holes you selected. (Each row in the Samples pane represents a specific through-hole.)

2. To group datapoints by their angle about a clustering axis, select the **Point** tab. Clusters are described by lines between their clustering axis and automatically determined cluster centers.
3. To group datapoints by their inclusion in a cluster, select the **Draw** tab. Inclusion is represented by an ellipse or hand-drawn shape.

4. To change the datapoint color display, in the Point or Draw tab:
   - Select the **Colors** checkbox to display colors for the datapoints by genotype. For a description of the colors, see page 87.
   - Deselect the **Colors** checkbox to display all datapoints in gray.

5. To zoom in or out:
   - **Zoom in** – Right-click in the corner of the area you want to view, drag diagonally across the area, then release the mouse. The selected area will be enlarged.
   - **Zoom out** – Right-click any where in the Scatter Plot. The entire plot reappears.
Datapoint color descriptions

The color of each datapoint in the Scatter Plot indicates the genotype calls made by the software.

<table>
<thead>
<tr>
<th>Color</th>
<th>Color description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>FAM™ dye homozygous</td>
</tr>
<tr>
<td>Green</td>
<td>FAM™ and VIC® dye heterozygous</td>
</tr>
<tr>
<td>Red</td>
<td>VIC® dye homozygous</td>
</tr>
<tr>
<td>Orange</td>
<td>Outlier</td>
</tr>
<tr>
<td>Cyan</td>
<td>Don’t Call</td>
</tr>
<tr>
<td>Black</td>
<td>No Call</td>
</tr>
</tbody>
</table>

To set outliers, see page 93.

To set Don’t Call samples, see page 99.

No Call samples are set by the software. The software sets a sample as No Call if its datapoint is outside the range of all clusters or within the range of two or more clusters.
View data in the Samples pane

Each row in the Samples pane represents a specific through-hole.

1. To select:
   - **Individual through-holes** – Click the row you want to view.
   - **Multiple through-holes, nonadjacent** – Press and hold the CTRL key, then click the rows you want to view.
   - **Multiple through-holes, adjacent** – Press the SHIFT key, then click the first and last rows of the block you want to view.

   In the Scatter Plot, the software displays a black circle around the datapoints for the through-holes you selected. (Each datapoint in the Scatter Plot represents a specific through-hole.)

2. To arrange rows in ascending or descending order, click a column heading.

3. To add new columns, use either the Sample Information dialog box or the Sample Plate dialog box, as described in the table below.
Do not use commas or periods in column names; text is case-sensitive. In the Samples pane, `SampleInfo.Properties` is prefixed to all new column names to differentiate them from the standard columns. If you assign a standard column name to a new column, the software will automatically rename it. For a description of the standard columns, see page 90.

<table>
<thead>
<tr>
<th>Dialog box</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Information dialog box</td>
<td>1. Click <strong>Edit</strong> to open the Samples Information dialog box.</td>
</tr>
<tr>
<td></td>
<td>2. Click <strong>Edit Columns</strong> to open the Columns For Sample Plate dialog box.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Add</strong>, select <strong>New Field</strong>, enter the new column name, then click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

| Sample Plate dialog box        | 1. Click **Edit** to open the Samples Information dialog box.             |
|                                | 2. Click next to the appropriate load number to open the Sample Plate dialog box. |
|                                | 3. Click **Edit Columns** to open the Columns For Sample Plate dialog box. |
|                                | 4. Click **Add**, select **New Field**, enter the new column name, then click **OK**. |
|                                | 5. Click **OK** to close the Sample Plate dialog box.                     |
|                                | 6. Repeat steps 1 through 5 for the remaining load(s).                     |
### Samples pane column descriptions

<table>
<thead>
<tr>
<th>Column name</th>
<th>Column description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenArray Serial Number</td>
<td>An alphanumeric code (for example, <strong>ABC01</strong>) for the TaqMan® OpenArray® Genotyping Plate. A user scans (via the barcode) or enters the serial number in the software [see step 3. on page 67].</td>
</tr>
<tr>
<td>Sample ID</td>
<td>The sample identification [user-defined]. A user enters the sample ID in the software [see &quot;Enter sample information&quot; on page 68]. If a sample ID was not entered, fields in this column are blank.</td>
</tr>
</tbody>
</table>
| Genotype String              | The genotype call made for the sample by the software or by a user:  
  - **VV** = VIC® dye homozygote  
  - **VF** = Heterozygote  
  - **FF** = FAM™ dye homozygote  
  - **No Call** or **Don't Call** = No genotype is called for the sample  
  - **Outlier** = The sample is set as an outlier  
  - **A**, **C**, **G**, **N**, or **T** = Allele information |
<p>| Consensus Genotype String    | The calculated genotype result for all assay replicates. |
| Replicate ID                 | Reserved for future use. |
| Address                      | The location of the assay on the TaqMan® OpenArray® Genotyping Plate (for example, <strong>A1a1</strong>). |
| Distance To Cluster Center   | The distance between the datapoint and the appropriate genotyping cluster line. |
| Confidence                   | A measurement between 0 and 1. Larger values indicate close proximity to the cluster line compared with other datapoints in the cluster. |
| Distance To Nearest Cluster In STDs | The distance between a datapoint and the nearest cluster line, expressed as standard deviation units. The standard deviation is calculated using all datapoints in the relevant cluster. |
| Distance To Next Nearest Cluster In STDs | The distance between a datapoint and the next nearest cluster line, expressed as standard deviation units. The standard deviation is calculated using all datapoints in the relevant cluster. |
| Through-Hole Index           | The identification number of the through-hole in which the assay was cycled and imaged. |
| VIC, FAM                     | The measurement of indicated dye fluorescence detected by the OpenArray® instrument. |
| Sample Plate Serial Number   | An alphanumeric code for the TaqMan® OpenArray® 384-Well Sample Plate (user-defined). A user enters the serial number in the software [see “Enter sample information” on page 68]. |
| Sample Address               | The well in the TaqMan® OpenArray® 384-Well Sample Plate from which the sample was transferred. |</p>
<table>
<thead>
<tr>
<th>Column name</th>
<th>Column description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Dilution</td>
<td>The sample concentration (user-defined). A user enters the sample dilution in the software [see “Enter sample information” on page 68]. If a sample dilution was not entered, fields in this column are blank.</td>
</tr>
<tr>
<td>Sample Description</td>
<td>A description of the sample (user-defined). A user enters the sample description in the software [see “Enter sample information” on page 68]. If a sample description was not entered, fields in this column are blank.</td>
</tr>
<tr>
<td>SampleInfo.Properties</td>
<td>Indicates a new column added by a user. All user-defined columns are prefixed with SampleInfo.Properties.</td>
</tr>
</tbody>
</table>
(Optional) Modify clustering parameters

After an imaging run, the OpenArray software automatically calls genotypes. If the automatic calls are not suitable for your experiment, you can modify the clustering parameters as follows:

- Set outliers (page 93)
- Adjust genotyping clusters (page 94)
- Adjust stringency (page 97)
- Adjust tolerance (page 98)
- Set Don’t Call samples (page 99)
- Exclude genotyping clusters from analysis (page 99)
- Draw genotyping clusters (page 101)

**IMPORTANT!** Modifications to clustering parameters are made only to the assay you are viewing, not to the entire project. To change the default settings for the entire project, see “Set project parameters” on page 103.

About the Auto functions

There are three Auto functions in the OpenArray software:

- **Auto button in the Samples pane** – The software re-calls a sample that a user has labeled *Don't Call* or *Outlier*, per the current settings. To use this Auto function, select the sample, then click **Auto** in the Samples pane.

- **Auto button in the Draw or Point tab** – The software determines genotype calling parameters for the current assay and re-calls the genotypes (FAM, Het, VIC, or No Call) for all samples applied to the current assay. To use this Auto function, select the assay, then click **Auto** in the Draw or Point tab.

- **Auto Reclassify All Assays** – The software determines the genotype calling parameters for all assays and re-calls the genotypes (FAM, Het, VIC, or No Call) for all samples. To use this Auto function, select **Action** > **Auto Reclassify All Assays**.

Save your changes to the project file

To save modifications made to the data, you must save the project file. If you do not save the project file, all your changes are lost after you close the file.

**IMPORTANT!** The software copies the run data from the plate data file to the project file. The files are not linked; that is, modifications you save to the project file (*.nix) are not saved to the corresponding plate data file (*.spd).

1. Select:
   - File > Save to save the changes to the current project file.
   - File > Save As to save the changes to a new project file. The File > Save As function allows you to perform multiple analyses of the same plate data file (*.spd).
2. Browse to a save location, then enter a file name.

Note: Project file names and save locations are user-defined. Project file names can be up to 255 characters in length, including spaces and non-alphanumeric characters. The following characters are not allowed: \ / : * ? " < > |.

3. Click Save.

Set outliers

If your data includes one or more datapoints with fluorescence that is very different from that of most of the other datapoints, you can set them as outliers. The software does not call outliers.

1. In the Samples pane or Scatter Plot, select the samples to set as outliers.

2. In the Samples pane, click Outlier. The software:
   - Labels each selected sample as Outlier in the Samples pane.
   - Removes the outliers from view in the Scatter Plot.
   - Recalculates the clusters without the outliers.

3. To view the outliers, select the Outliers checkbox in the Point or Draw tab. The outliers appear in the Scatter plot as orange datapoints.

4. To include an outlier back in the analysis:
   a. Select the sample.
   b. Click Auto in the Samples pane.
Adjust genotyping clusters

Use the Point and Draw tab tools to adjust genotyping clusters. You can:
- Drag and drop to move the clusters and exclusion bars (this page)
- Use the Auto-Classification Wizard to move the clusters and exclusion bars (this page)
- Modify the cluster shapes (page 96)

Drag and drop
1. In the OpenArray software, select the **Point** tab.
2. Drag and drop the:
   - Cluster center
   - Exclusion bar

Auto-Classification Wizard
1. In the OpenArray software, select the **Point** tab.
2. Click **Set**.
Chapter 5  Analyze the Run Data
(Optional) Modify clustering parameters

3. At the prompt, exclude the datapoints close to the axis: Select a datapoint where all the datapoints with less fluorescence will be marked No Call. For example, you may want to exclude no template controls (NTCs).

4. At the prompt, set the clustering axis: Click where all the cluster lines appear to intersect. Typically, the cluster lines intersect near the origin.

5. At the prompts, click where you want to set the new:
   a. FAM dye cluster center
   b. Heterozygote cluster center
   c. VIC dye cluster center.
6. To make further changes, repeat steps 1. through 5.

7. Click **Apply** to apply the changes.

**Modify the cluster shapes**

You can rotate, resize, reshape, and move the ellipses drawn around each genotyping cluster. These adjustments change the genotype call for datapoints that were outside and are now inside the cluster and visa-versa.

To modify the cluster shapes:

1. In the OpenArray software, select the **Draw** tab. The software automatically draws ellipses for each genotype.

   **Note:** The software does not call datapoints that are outside a cluster area or are within more than one cluster area.

2. Select the cluster you want to modify. You can:
   - Select , then click the cluster.
   - Select **Tools** > Pointer, then click the cluster.

   The software highlights the selected clusters as shown.

3. To rotate the cluster: Click and drag the green handle in the direction you want to rotate the cluster.
4. To resize the cluster: Click and drag the appropriate blue circle outward (to enlarge) or inward (to shrink).

![Cluster: Before](image1)

Click and drag a blue circle.

![Cluster: After](image2)

5. To reshape the cluster (for example, to include a nearby point): Click and drag the appropriate white circle in the direction you want the cluster to be stretched.

![Cluster: Before](image3)

Click and drag a white circle.

![Cluster: After](image4)

6. To move the cluster: Click and drag the cluster to move it to the desired position.

Adjust stringency

The software assigns No Call status to datapoints that are too far from their cluster line. You can change the number of standard deviations from cluster lines to the datapoints that are included in the genotype call.

1. In the OpenArray software, select the Point tab.

2. In the Stringency field, enter a positive number (for example, 2) or enter Infinity.
3. Click **Apply**. The software assigns *No Call* status to any datapoints that are farther from the cluster than the value entered. *No Call* datapoints are black.

### Adjust tolerance

You can adjust how close a datapoint in one cluster can be to an adjacent cluster line before the software assigns *No Call* status.

1. In the OpenArray software, select the Point tab.
2. In the Tolerance field, enter a standard deviation value.
   
   **Note:** Larger tolerance values result in more *No Call* datapoints.
3. Click **Apply**. The software assigns *No Call* status to any points that are within the tolerance value of more than one cluster line. *No Call* datapoints are black.
Set *Don’t Call* samples

To prevent a sample from being called by the software:

1. In the Samples pane or Scatter Plot, select the sample.
2. Click **Don’t Call**. In the Scatter Plot, the datapoint for the selected sample turns cyan.
3. To include the datapoint back in the analysis, select it, then click **Auto** in the Samples pane.

Exclude genotyping clusters from analysis

You can configure the software to identify fewer than three genotypes. For example, if you know your samples do not include any FAM dye homozygotes, you can remove the FAM dye from the analysis.

To exclude a genotyping cluster using the Draw tab

1. Select the **Draw** tab.
2. In the Scatter Plot, select the appropriate genotyping cluster, then press the **DELETE** key. The genotyping cluster disappears from the Scatter Plot; in the Clusters Present area, the corresponding genotype (FAM, Het, or VIC) is automatically deselected. The software analyzes the data without the excluded genotyping cluster.

3. To include the genotyping cluster back in the analysis:
   a. In the Point or Draw tab, select the excluded genotype: **FAM**, **Het**, or **VIC**.
   Or
   b. Redraw the cluster (see “Draw genotyping clusters” on page 101).

To exclude a genotyping cluster using the Clusters Present area

1. Select the **Point** or **Draw** tab.

2. In the Clusters Present area, deselect the genotype (FAM, Het, or VIC), you do not have. The genotyping cluster disappears from the Scatter Plot. The software analyzes the data without the excluded genotyping cluster.
3. To include the genotyping cluster back in the analysis:
   a. In the Point or Draw tab, select the excluded genotype: **FAM, Het, or VIC**.
   
Or

   b. Redraw the cluster (see “Draw genotyping clusters” on page 101).

**Draw genotyping clusters**

Note: When you create a new genotyping cluster, the software automatically deletes the previously configured cluster for that genotype.

1. In the OpenArray software, select the **Draw** tab.

2. Select the appropriate drawing tool for the genotyping cluster you want to recreate (for example, 🔋). Or select Tools ➤ **Draw <dye> Tool** (where <dye> is **FAM, Het, or VIC**). The software deletes the previously configured cluster for that genotype.

3. In the Scatter Plot, click and draw a line around all the datapoints you want to include in the new genotyping cluster.
(Optional) Modify project files

Project files (*.nix) are the files you view and modify in the OpenArray software. You can modify project files as follows:

- Add plate data files (*.spd) (this page)
- Remove plate data files (*.spd) (page 103)
- Set project parameters (page 103)

Note: For more information on project files, see page 64.

Add plate data files (*.spd)

1. In the OpenArray software, click Add to open the Add/Remove Plate Files dialog box. The software displays the plate data files (*.spd) currently in the project.

2. Click Add File, then browse to and select the plate data file(s) you want to add. Note: To select multiple plate data files, press and hold the CTRL or SHIFT key.

3. Click Open. The software:
   - Displays the selected plate data files in the Add/Remove Plate Files dialog box.
   - Copies the run data from the plate data file to the project file.

   Note: When you add a plate data file, the software copies the run data from the plate data file to the project file. The files are not linked; that is, any changes you make in the project file (*.nix) are not made in the corresponding plate data file (*.spd).

4. Click Done. The software automatically calls the genotypes for the revised group of plate data files, using your current settings.
Remove plate data files (*.spd)

1. In the OpenArray software, click Add to open the Add/Remove Plate Files dialog box. The software displays the plate data files (*.spd) currently in the project.

2. Select the plate data file to remove, then click Remove Files. The software:
   • Removes the selected plate data files from the Add/Remove Plate Files dialog box.
   • Removes the run data for the selected plate data files from the project file.

Note: When you remove a plate data file from a project, the genotyping calls for the samples in that plate data file are lost. In addition, the genotyping calls for the remaining samples in the project change.

3. Click Done. The software automatically calls the genotypes for the revised group of plate data files, using your current settings.

Set project parameters

IMPORTANT! When you set project parameters, the settings are applied to the current project file and any future project files.

1. In the OpenArray software, select Edit → Project Settings to open the Project Settings dialog box.
2. Select the **Typical** tab, then edit the parameters as needed:

<table>
<thead>
<tr>
<th>Typical Tab</th>
<th>Parameter</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Stringency</td>
<td>Enter a positive number (for example, 2.0) or enter <strong>Infinity</strong> to represent a number of standard deviations. After you save the parameters, the software assigns a <strong>No Call</strong> status to any datapoints that are further from the cluster line than the entered value.</td>
</tr>
<tr>
<td></td>
<td>Tolerance</td>
<td>Enter a positive number (for example, 2.5) to indicate how close a datapoint in one cluster may be to an adjacent cluster line. After you save the parameters, the software assigns a <strong>No Call</strong> status to any datapoints that are within the specified standard deviations of two cluster lines.</td>
</tr>
<tr>
<td></td>
<td>Mode</td>
<td>From the dropdown menu, select the mode (Point or Draw) you most frequently work within as your default. After you save the parameters, the corresponding tab appears in front.</td>
</tr>
<tr>
<td></td>
<td>Clusters Present</td>
<td>Deselect the genotypes you do not have. For example, if you know your samples do not include any FAM dye homozygotes, deselect <strong>FAM</strong>.</td>
</tr>
<tr>
<td></td>
<td>View Settings</td>
<td>Select the items (outliers, cluster lines, colors) to display in the Scatter Plot.</td>
</tr>
</tbody>
</table>

3. Select the **Advanced** tab, then edit the parameters as needed:

<table>
<thead>
<tr>
<th>Advanced Tab</th>
<th>Parameter</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>System Logging Level</td>
<td>The system default is <strong>Some Information</strong>. Only adjust this value when asked by an Applied Biosystems service representative.</td>
</tr>
<tr>
<td></td>
<td>Auto Classify Data in Draw Mode</td>
<td>Deselect this mode if you do not want the software to automatically call genotypes on the Draw tab.</td>
</tr>
<tr>
<td></td>
<td>Enhanced Spread Display</td>
<td>If checked, the software attempts to remove noise from data in the project.</td>
</tr>
</tbody>
</table>

4. Click **OK** to save the parameters. The software applies all parameters to all assays.
(Optional) Publish data

Publish data for use in reports, spreadsheets, and so on. You can:

- Copy and paste Scatter Plots (this page)
- Export genotype tables (this page)
- Export *.csv files (page 106)

Copy and paste Scatter Plots

You can copy and paste the Scatter Plots into other software applications, such as Microsoft® PowerPoint Software.

1. (Optional) In the OpenArray software, zoom in on an area of the Scatter Plot (see step 5. on page 86).
2. Click in the plot area, then select Edit ▶ Copy.
3. Paste the Scatter Plot into the appropriate software application.

Export genotype tables

You can export genotype information from your project in a table format. The table includes the following information:

- Genotyping plate serial number
- Sample ID
- Sample description
- Genotype calls

1. Select the appropriate tab to export from (the Point or Draw tab).

Note: The Point and Draw tabs in the OpenArray software are not connected. For example, when you analyze data in the Point tab, the Draw tab does not reflect that analysis. Before you export genotyping results, be sure that the appropriate tab is active.

2. In the OpenArray software, select File ▶ Export Genotype Table to open the Export Genotype Table dialog box.
   Note: Do not select Export Consensus Genotypes or Export Individual and Consensus Genotypes. These functions are not currently supported.

4. Select the row and column contents:
   - If you want each row to contain sample information and each column to contain assay information, deselect Transpose Output.
   - If you want each row to contain assay information and each column to contain sample information, select Transpose Output.

5. Click OK to open a save dialog box.

6. Browse to a save location, name the file, then click Save. A *.csv file is saved to the specified location.

7. To view the exported table, open it in Microsoft® Excel Software or another spreadsheet application.

---

Export *.csv files

You can export data from your project as a comma-delimited file (*.csv). The *.csv file includes (but is not limited to) the following data:

- Assay information from the plate setup file (*.spf)
- Sample information
• Genotype calls and associated parameters
• Fluorescence intensity data

1. Select the appropriate tab to export from (the Point or Draw tab).

   Note: The Point and Draw tabs in the OpenArray software are not connected. For example, when you analyze data in the Point tab, the Draw tab does not reflect that analysis. Before you export genotyping results, be sure that the appropriate tab is active.

2. In the OpenArray software, select File ▶ Export CSV. The following message appears:

   ![OpenArray SNP Genotyping Analysis Software](image)

   Note: Exported *.csv files cannot be reopened in the OpenArray software. Applied Biosystems recommends that you save the project file (*.nix) before exporting the *.csv file.

3. Click OK to close the message and open a save dialog box.

4. Browse to a save location, name the file, then click Save. A *.csv file is saved to the specified location.

5. To view the exported *.csv file, open it in Microsoft® Excel Software or another spreadsheet application.
(Optional) Perform downstream analysis

You can perform downstream analysis with Applied Biosystems AutoCaller™ Software. The AutoCaller software is a SNP genotyping analysis tool and client-server program that you can use to efficiently analyze, edit, and compare genotyping assays run on the OpenArray® system.

Features

The AutoCaller software allows you to:

- Import data from the OpenArray software project files, then manage the data in a database.
- Search the database for assays using specific search criteria.
- Easily view data in a variety ways (plots, statistics, status codes, and so on).
- Edit data (your edits are saved to the database).
- Overlay data from multiple plates.
- Export data.

Export to the AutoCaller software

1. In the OpenArray software, select **File ▶ Export to Applied Biosystems AutoCaller™** ... to open a save dialog box.

2. Browse to a save location, name the file, then click Save. An *.xml file is saved to the specified location.

3. To import the file into the AutoCaller software, refer to the **Applied Biosystems AutoCaller™ Software User Guide**.
This appendix covers:

- Contact Applied Biosystems ........................................................... 109
- Required materials ............................................................................. 110
- Computer ........................................................................................... 111
- OpenArray® AutoLoader and accessories ......................................... 112
- OpenArray® instrument ................................................................. 114

**Contact Applied Biosystems**

Contact an Applied Biosystems service representative with questions regarding preventative maintenance of the OpenArray® platform.

You may be asked for your software version, instrument firmware version, and/or instrument serial number. To access this information:

1. Be sure that you are on a computer that is connected to the OpenArray® instrument.

2. In the OpenArray® SNP Genotyping Analysis Software, select Help ▶ About.

**IMPORTANT!** Only an Applied Biosystems service representative should clean or service components not covered in this appendix.
## Required materials

<table>
<thead>
<tr>
<th>Product</th>
<th>Source</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>For the computer</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpenArray® SNP Genotyping Analysis Software Installation CD</td>
<td>Applied Biosystems</td>
<td>20441</td>
</tr>
<tr>
<td></td>
<td>The CD ships with the OpenArray® platform.</td>
<td></td>
</tr>
<tr>
<td>Backup storage (for example, CDs)</td>
<td>User-supplied</td>
<td></td>
</tr>
<tr>
<td><strong>For the OpenArray® AutoLoader and accessories</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clean, dry cloth</td>
<td>Major laboratory suppliers (MLS)</td>
<td></td>
</tr>
<tr>
<td>Ethanol†</td>
<td>MLS</td>
<td></td>
</tr>
<tr>
<td>Bleach, 10%†</td>
<td>MLS</td>
<td></td>
</tr>
<tr>
<td>(Optional) Filtered 100% compressed nitrogen gas or residue-free compressed air canister, for drying the plate holder, tip blocks, and plate guides</td>
<td>MLS</td>
<td></td>
</tr>
<tr>
<td>(Optional) Hand-held spray attachment for the compressed gas/air canister</td>
<td>MLS</td>
<td></td>
</tr>
<tr>
<td><strong>For the OpenArray® instrument</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Powder-free nitrile gloves</td>
<td>MLS</td>
<td></td>
</tr>
<tr>
<td>M4 hex wrench</td>
<td>MLS</td>
<td></td>
</tr>
<tr>
<td>12-inch Contec non-laser edge polyknit cloths</td>
<td>VWR</td>
<td>PNHS1212</td>
</tr>
<tr>
<td>Ethanol†</td>
<td>MLS</td>
<td></td>
</tr>
<tr>
<td>Clean, dry cloth</td>
<td>MLS</td>
<td></td>
</tr>
</tbody>
</table>

† For the SDS of any chemical not distributed by Applied Biosystems, contact the chemical manufacturer. Before handling any chemicals, refer to the SDS provided by the manufacturer, and observe all relevant precautions.
Computer

Install the software

An Applied Biosystems service representative installs the OpenArray\textsuperscript{®} SNP
Genotyping Analysis Software on the system computer. You can also install the
OpenArray software on other computers not connected to the instrument (for
example, your office computer).

Use the TaqMan\textsuperscript{®} OpenArray\textsuperscript{®} Genotyping Software Installation CD that is shipped
with the OpenArray\textsuperscript{®} platform. Software installation takes approximately 5 minutes.

1. Insert the Installation CD in your CD drive. A message appears stating that files
are being extracted.
   Note: If Microsoft\textsuperscript{®}.Net Runtime v1.1 is not installed, the installation program
   prompts you to install it. Select Yes.

2. Verify that the Installation Wizard appears, but do not click Next yet.

3. From the Start menu, select My Computer. If folders are not listed in the left
   pane, select Folders in the My Computer toolbar to make them visible.

4. At the prompt, select to install software that is NOT FOR INSTRUMENT
   CONTROL USE.

5. In the Installation Wizard, click Next. Enter your name and organization. If there
   are multiple user accounts on this computer, select whether you want to install
   the software for all users or just yourself, then click Next.

6. Click Next again to select the default directory for the plate setup files (*.spf).

7. When the Ready to Install window appears, click Next. The installation wizard
   installs the software. When a message appears stating the software is successfully
   installed, click Finish.

Open the software for the first time

1. On the computer, start the OpenArray software:
   - Double-click the software icon .
   - or
   - Select Start \rightarrow All Programs \rightarrow BioTrove \rightarrow OpenArray\textsuperscript{®} SNP Genotyping
     Analysis Software <version number> \rightarrow OpenArray\textsuperscript{®} SNP Genotyping
     Analysis Software.

2. Click I Accept to accept the License Agreement.

3. If you have spyware removal software installed on this computer, you may
   receive messages regarding changes in the registry. Enable registry updates for
   the software.
Clean the hard drive

Periodically remove plate data files (*.spd) from the instrument computer. The *.spd files contain run (imaging and genotyping) data and are located in the images folder:

<drive>\images\<run date>\<run number>

where:
<drive> is the computer drive on which the OpenArray software is installed. The default installation drive is the C: drive.
<run date> is the date the run was performed.
<run number> is the chronological run number.

Before removing the *.spd files, be sure to:

1. Close the OpenArray software.
2. Back up the *.spd files (that is, save the files to another location).

OpenArray® AutoLoader and accessories

Clean the exterior

Clean the outside of the AutoLoader by wiping with a clean, dry cloth. Do not use solvents.

Clean the interior

If liquids or other materials spill inside the AutoLoader:

1. Press the power switch on the back of the AutoLoader turn it off, then unplug the power cord from the electrical outlet.

2. Call your Applied Biosystems service representative.
Calibrate the AutoLoader

The AutoLoader automatically calibrates each time it is turned on and each time someone stops the AutoLoader. To calibrate the AutoLoader at another time, on the Welcome screen, press the button under HOME.

Clean the accessories

After each use, clean the following AutoLoader accessories:

- OpenArray® Plate Guide Set
- OpenArray® AutoLoader Tip Block
- OpenArray® AutoLoader Plate Holder

To clean the AutoLoader accessories:

1. Soak the plate guide, tip block, and/or plate holder in 10% bleach for at least 10 minutes.

2. Rinse with water, then rinse with ethanol.

3. Let the parts completely air dry. If they are needed immediately, wipe with paper towels and spray with compressed nitrogen gas.
OpenArray® instrument

Clean the lens

IMPORTANT! The lens is a vital part of your instrument and is easily scratched. Always handle the lens gently and never drop it. If the lens is damaged and needs to be replaced, you will not be able to operate your NT instrument until Applied Biosystems can ship you a new lens.

If condensation or dirt builds up on the lens:

1. Put on powder-free nitrile gloves.

2. With an M4 hex wrench, unscrew all six screws on the lid by turning counterclockwise.

3. Remove the metal ring and the O-ring.
4. Place your hand underneath the lens and carefully pop it out of position. Remove the lens, touching only the outside edge.

5. Spray a polyknit cloth with ethanol, then wipe the lens until there are no streaks on the lens.

6. Clean the lid:
   a. Spray a polyknit cloth with ethanol.
   b. Clean the lip of the lid.
c. Spread the polyknit cloth on the block and close the lid for 10 seconds.

d. Clean the fingers on the top of the lid individually.

7. Be sure that the lens is frosted side up (it should be in a concave position, like a bowl), then place the lens back into the OpenArray® instrument.

8. Place the O-ring on the lip, then place the metal ring on top of the O-ring.

9. With the M4 hex wrench, partially screw all screws on the lid by turning clockwise. After all are flush, but not tight, screw them in all the way. To reduce pressure on the lens, tighten screws on two opposite sides, then on the other two opposite sides.

Clean the sample block

Clean the OpenArray® instrument sample block by wiping with a clean, dry cloth. Do not use solvents.

Clean the exterior

Clean the outside of the OpenArray® instrument by wiping with a clean, dry cloth. Do not use solvents.
APPENDIX B

Troubleshooting

This appendix covers:

■ Loading sample .......................................................... 117
■ Imaging .............................................................. 117
■ Analysis .............................................................. 120
■ Miscellaneous ...................................................... 122

For more troubleshooting information, refer to the TaqMan® OpenArray® Genotyping Troubleshooting Guide (PN 4401671).

Loading sample

<table>
<thead>
<tr>
<th>Message</th>
<th>Circumstances</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Begins with: “Please cycle power”</td>
<td>The OpenArray® AutoLoader needs to be power-cycled.</td>
<td>Turn the AutoLoader off for a few seconds, then switch it back on. It should clear itself.</td>
</tr>
<tr>
<td>Begins with: “Error in subsystem”</td>
<td>A technician may need to look at the AutoLoader.</td>
<td>Contact Applied Biosystems.</td>
</tr>
</tbody>
</table>

Imaging

<table>
<thead>
<tr>
<th>Message</th>
<th>Circumstances</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do you want to keep blocking this program?</td>
<td>Windows firewall software is attempting to protect your computer by making sure you want to launch new software.</td>
<td>Click Unblock to close the LogServer window. Click Unblock to close the CyclopsSupervisor window.</td>
</tr>
<tr>
<td>OpenArray® SNP Genotyping Software must be run with English (United States) language settings.</td>
<td>At this time, the software requires that English (United States) is selected. The default setting on your computer is not English (United States).</td>
<td>Close the software. Select Start ➤ Control Panel ➤ Regional and Language Settings. On the Regional tab, select English (United States) as the Standards and Formats setting. Restart the software.</td>
</tr>
<tr>
<td>Warning! This application was previously shut down improperly. Data from the previous run may have been lost.</td>
<td>The electrical power failed and shut down your computer. Or You closed the application in the Windows Task Manager.</td>
<td>Data from the run currently in progress are lost. Restart the instrument and computer and re-image the TaqMan® OpenArray® Genotyping Plates for the current run. Data from previous runs are preserved.</td>
</tr>
<tr>
<td>Message</td>
<td>Circumstances</td>
<td>Resolution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OpenArray® SNP Genotyping Software encountered errors while loading the following files.</td>
<td>You have attempted to add a plate data file (*.spd) that you do not have permission to open, is already open, or is not valid.</td>
<td>Click OK to close the message. Check to make sure you are adding a valid file and that you have access to it. If needed, ask your administrator to upgrade your permissions level.</td>
</tr>
<tr>
<td>Couldn’t open document.</td>
<td>You have attempted to open a project file (*.nix) that you do not have permission to open, is already open, or is not valid.</td>
<td>Click OK to close the message. Check to make sure you are opening a valid file and that you have access to it. If needed, ask your administrator to upgrade your permissions level.</td>
</tr>
<tr>
<td>The following file(s) already exist in the document and will not be loaded.</td>
<td>You have attempted to add plate data files (*.spd) that are already included in the project.</td>
<td>Click OK to close the message. Add plate data files not already in the project.</td>
</tr>
<tr>
<td>This document contains 50 OpenArray® plates - the maximum allowed. Please create a new document to perform additional experiments.</td>
<td>Projects can contain a maximum of 50 plate data files (*.spd). You have attempted to add or image files that would exceed the maximum number.</td>
<td>Add the plate data files to a different project. Or Open a different project file for imaging the genotyping plates.</td>
</tr>
<tr>
<td>There is not enough free space on which to save the new data. Please move or delete files on your hard drive so that 3.59 GB are available.</td>
<td>Before you begin each run, the software automatically verifies whether you have enough storage space for the imaging data you are about to collect. You receive this message if you have limited storage space remaining on your hard drive.</td>
<td>Check the amount of disk space on your hard drive. Select Start &gt; My Computer, then double-click Local Disk. Review your system storage space statistics (right side, blue bar). Move or delete files as needed to make space, then image the genotyping plates.</td>
</tr>
<tr>
<td>Plate File Not Found. Load CD for this Plate or choose Locate File.</td>
<td>The software matches the serial number of each genotyping plate with its corresponding plate setup file (*.spf). You receive this message if no match is found.</td>
<td>If the plate setup file is located in another directory, click Locate Files, browse to the appropriate directory, then select the file. Or If you did not copy the files from the CD that was shipped with your order to your computer, insert the CD and copy the files.</td>
</tr>
<tr>
<td>Failed to open Plate File. The file may be corrupt or may require a newer version of this software.</td>
<td>The software cannot open the plate setup file (*.spf).</td>
<td>Reload the plate setup file from the CD that was shipped with your order. If this does not resolve the problem, contact Applied Biosystems.</td>
</tr>
<tr>
<td>Camera not ready. Please wait and try again when status bar shows Camera is initialized.</td>
<td>After you enter serial numbers in the Input Plate Serial Numbers dialog box, you click Image. This message appears if the camera is not ready.</td>
<td>Wait until the red indicator circle in the status bar (lower right corner) turns green. Click Image again.</td>
</tr>
<tr>
<td>Plate File in Position x Not Loaded.</td>
<td>The plate setup file (*.spf) is not located in the default folder where the software can locate it.</td>
<td>Load the plate setup file from the CD that was shipped with your order to the default folder: C:\Program Files\BioTrove\PLATEFILES. Or Click Browse, browse to the folder where the plate setup file is stored, select it, then click OK.</td>
</tr>
<tr>
<td>Message</td>
<td>Circumstances</td>
<td>Resolution</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
<td>------------</td>
</tr>
<tr>
<td>Multiple OpenArray® plates with the same serial number have been selected.</td>
<td>The same serial number was given for the highlighted positions in the Input Plate Serial Numbers dialog box.</td>
<td>Check the serial numbers on the genotyping plates you loaded in the instrument. Re-enter the correct serial numbers by scanning or typing them. Click Image.</td>
</tr>
<tr>
<td>OpenArray® plate serial number is identical to existing one in document.</td>
<td>The serial number in the highlighted position is the same as a genotyping plate serial number already in your project file (*.nix).</td>
<td>Check the serial numbers on the genotyping plates you loaded in the instrument. Re-enter the correct serial numbers by scanning or typing them. Click Image.</td>
</tr>
<tr>
<td>Failed to import the file named xyz.</td>
<td>Either the sample information file (*.csv) you are trying to import is invalid or you do not have permission to open it.</td>
<td>Click OK to close the message. Check to make sure you are opening a valid *.csv file and that you have access to it. If needed, ask your administrator to upgrade your permissions level.</td>
</tr>
<tr>
<td>Please select a valid plate file before editing the sample applied to it.</td>
<td>The plate setup file (*.spf) for the genotyping plate for which you are trying to add sample information is either not found or corrupt.</td>
<td>If the file is not found: Load the plate setup file from the CD that was shipped with your order to the default folder: C:\Program Files\BioTrove\PLATEFILES. Or click Browse, browse to the folder where the plate setup file is stored, select it, then click OK. If the file is corrupt, contact Applied Biosystems.</td>
</tr>
<tr>
<td>Stop Imaging has been selected. Are you sure that you want to stop imaging?</td>
<td>You can stop imaging while in progress. From the Actions menu, select Stop Imaging. This message appears.</td>
<td>To continue imaging, click No. To stop imaging, click Yes. This message appears: “If you stop imaging, the project file will contain partially collected imaging data. Do you want to keep the partially collected data?” Click Yes, No, or Cancel. If you click Cancel, imaging will resume.</td>
</tr>
<tr>
<td>Status bar reads: &quot;Stopping Imaging&quot;</td>
<td>The instrument is responding to your request to stop imaging.</td>
<td>Wait until the instrument is ready, then open the door to retrieve your genotyping plates.</td>
</tr>
<tr>
<td>Status bar reads: “Failed to detect the instrument.”</td>
<td>The computer is not able to communicate with the instrument.</td>
<td>If you are running the software on a computer that is not connected to the instrument (for example, your office computer), no action is required. Otherwise, power off the instrument, then make sure all cables are securely connected. Power on the instrument and restart the software. If the message reappears after following this procedure, contact Applied Biosystems.</td>
</tr>
<tr>
<td>Status bar reads: &quot;Initializing Camera...&quot;</td>
<td>The camera inside the instrument is initializing.</td>
<td>Wait until the status bar updates, indicating that the camera is initialized. If the camera fails to initialize, the status bar will read: “Failed to detect the instrument.”</td>
</tr>
</tbody>
</table>
### Appendix B  Troubleshooting

#### Analysis

<table>
<thead>
<tr>
<th>Message</th>
<th>Circumstances</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status bar reads: &quot;LED Test Waiting for CCD Temp &lt;1.0 °C.&quot;</td>
<td>The camera needs to cool off before imaging can proceed.</td>
<td>Wait until the status bar updates, indicating that the camera temperature is now below 1.0 °C. If the camera fails to cool, the status bar reads: “Failed to detect the instrument.”</td>
</tr>
<tr>
<td>Status bar reads: &quot;Waiting for CCD Temp &lt;1.0 °C.&quot;</td>
<td>The LED calibration test is running.</td>
<td>Wait until the status bar updates, indicating the LED test is complete.</td>
</tr>
<tr>
<td>Status bar reads: &quot;LED Test Running.&quot;</td>
<td>Your instrument is ready to image.</td>
<td>Continue with the imaging procedure.</td>
</tr>
</tbody>
</table>

### Message Circumstances Resolution

- **Warning! This application was previously shut down improperly. Unsaved data from the previous run may have been lost.**
  - The electrical power failed and shut down your computer. Or
  - You closed the application in the Windows Task Manager.
  - You will lose any unsaved data. Restart your computer and continue editing.

- **OpenArray® SNP Genotyping Software encountered errors while loading the following files.**
  - You have attempted to add a plate data file (*.spd) that you do not have permission to open, is open in another software application, or is not valid.
  - Click OK to close the message. Check to make sure you are adding a valid plate data file and that you have access to it. If needed, ask your administrator to upgrade your permissions level.

- **Couldn’t open document.**
  - You have attempted to open a project file (*.nix) that you do not have permission to open, is open in another software application, or is not valid.
  - Click OK to close the message. Check to make sure you are opening a valid file and that you have access to it. If needed, ask your administrator to upgrade your permissions level.

- **The following file(s) already exist in the document and will not be loaded.**
  - You have attempted to add plate data files (*.spd) that are already included in the project.
  - Click OK to close the message. Add plate data files not already in the project.

- **This document contains 50 OpenArray® plates - the maximum allowed. Please create a new document to perform additional experiments.**
  - Projects can contain a maximum of 50 plate data files (*.spd). You have attempted to add or image files that would exceed the maximum number.
  - Add the plate data files to a different project. Or
  - Open a different project file for imaging the genotyping plates.

- **Are you sure that you want to apply these settings to all items in this project?**
  - You are updating settings for all assays in a project file (*.nix). From the Edit menu, select Project Settings.
  - Click OK to confirm your changes. Or
  - Click Cancel.
<table>
<thead>
<tr>
<th><strong>Message</strong></th>
<th><strong>Circumstances</strong></th>
<th><strong>Resolution</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Only one character allowed in the allele.</td>
<td>In the Reporter 1 Sequence and Reporter 2 Sequence columns of the Assays pane, you can enter the one-letter character representing the reporter dye being measured.</td>
<td>Enter the appropriate character in the column: F (FAM™ dye) V (VIC® dye) N (non-specific)</td>
</tr>
<tr>
<td>You must have enough datapoints for the number of clusters you are finding in your data. Deselect genotypes or auto-call datapoints as appropriate. Clustering Not Possible.</td>
<td>There are not enough datapoints to represent selected genotypes for the current assay.</td>
<td>You need to add datapoints to the cluster. You can: Select datapoints that are Don’t Call or Outlier, then select Auto in the Samples pane to have them called again. Move the exclusion area so that more datapoints are called. Image more genotyping plates into this project file (*.nix).</td>
</tr>
<tr>
<td>You may not reduce the number of clusterable datapoints below the number of clusters you are finding in your data. Deselect genotypes or auto-call datapoints as appropriate.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Failed to save xyz.nix.</td>
<td>You have attempted to save a file on a local or network location for which you do not have permission, or the file is open in another software application, or the file is on a drive that does not have enough storage space.</td>
<td>Make sure you have permission to save to the location. If needed, ask your administrator to upgrade your permissions level. Make sure there is adequate space available; you can move or delete files to make space.</td>
</tr>
<tr>
<td>Failed to export the Genotype table to xyz.csv.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Failed to export data to xyz.csv.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>You have chosen to export this file as a .csv (comma separated values) file. Once the export is complete, the .csv file will not open in the SNP Genotyping software. It is recommended that you save this file first as a .nix file. Do you wish to proceed with the export to *.csv?</td>
<td>Since <em>.csv files can’t be re-opened as project files, you need to save both a project file (</em>.nix) and a *.csv file.</td>
<td>If desired, select Don’t show this message again. Click OK. The Export CSV dialog box appears. Select an option: To export the file, browse to the appropriate directory, enter a filename, then click Save. To cancel the export, click Cancel.</td>
</tr>
<tr>
<td>This document has been modified. Do you want to save?</td>
<td>When you close a file containing changes you haven’t saved, you are asked if you want to save your changes.</td>
<td>To save changes, click Yes. To close without saving the changes, click No. To return to the file and continue making edits, click Cancel.</td>
</tr>
</tbody>
</table>
## Miscellaneous

<table>
<thead>
<tr>
<th>Message</th>
<th>Circumstances</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to save License Agreement.rtf.</td>
<td>You attempted to save the software license agreement in a folder that don’t have permission to save in, or that does not have enough disk space available.</td>
<td>Click OK to close the message. Check to make sure you have access to the folder and that it has enough storage space. Retry the save. If necessary, save the license agreement in a different folder.</td>
</tr>
<tr>
<td>This application encountered an error and must quit.</td>
<td>The software has encountered a problem that forces it to close.</td>
<td>If possible, save your changes to a location that is different from where you previously saved them. Contact Applied Biosystems.</td>
</tr>
<tr>
<td>This application encountered an error. Please save all changes and quit the application.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Before you load the TaqMan® OpenArray® 384-Well Sample Plate with DNA samples (page 43), you need to calculate the required:

- Starting concentration of the genomic DNA (gDNA) sample (this page)
  
  Note: The starting concentration is the concentration of the gDNA sample prior to adding it to the sample plate.

- Volume of TaqMan® OpenArray® Genotyping Master Mix and (if needed) water (page 125)

### About the Sample Tracking & Calculator Tool

The Sample Tracking & Calculator Tool is a spreadsheet created with the Microsoft® Excel® Software. You can use the tool to quickly calculate the required amounts of gDNA and master mix. Applied Biosystems provides the Sample Tracking & Calculator Tool during training.

### Calculate the starting concentration of gDNA

Applied Biosystems recommends that you add 250 haploid copies of gDNA to each through-hole of a TaqMan® OpenArray® Genotyping Plate. To calculate the required concentration:

1. Determine the genome size in megabases (Mb) or determine the picogram (pg) quantity:
   
   - **Genome size** – For humans, 1 haploid copy of human genome is equal to 3300 Mb.
   
   - **Picogram (pg) quantity (C-value)** – For humans, the pg quantity is 3.3.
     
     Note: To obtain the genome size or pg quantity for other species, go to [www.genomesize.com](http://www.genomesize.com), or use another trusted source.

2. Browse to and open the Sample Tracking & Calculator Tool to start the Excel software.

3. Select the gDNA Calculator tab.
4. In the spreadsheet, enter the:
   - Genome size in the yellow box.
   - Or
   - Picogram quantity in the blue box.

   **How do I determine the starting concentration?**

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1a</td>
<td>Enter the size of the genome (in terms of length) in the yellow box, or</td>
</tr>
<tr>
<td>Step 1b</td>
<td>Enter the pg quantity of haploid genome from <a href="http://www.genomesize.com">www.genomesize.com</a> (C value) in the blue box</td>
</tr>
<tr>
<td>Step 2</td>
<td>Convert the size of 1 haploid copy from length to mass</td>
</tr>
<tr>
<td>Step 3</td>
<td>Convert the mass of 1 haploid copy from pg to ng</td>
</tr>
<tr>
<td>Step 4</td>
<td>Multiply the mass of 1 haploid copy by the # of copies required per through-hole (250 copies)</td>
</tr>
<tr>
<td>Step 5</td>
<td>Divide the mass of 250 copies by the volume per through-hole</td>
</tr>
<tr>
<td>Step 6</td>
<td>Multiply the concentration of gDNA required per through-hole by the dilution factor constant (2)</td>
</tr>
<tr>
<td>Step 7</td>
<td>Result = required starting concentration in ng/μL (round to the nearest whole number)</td>
</tr>
</tbody>
</table>

   The Sample Tracking & Calculator Tool calculates the required starting concentration (in ng/μL) of the gDNA sample, rounded to the nearest whole number.

   **Example**

   The figures below show the results for human DNA.

   Note: The final result may vary slightly due to rounding off by the calculator.
## Calculate the volume of master mix and water

The Master Mix Calculator aids in determining:

- The volume of gDNA and water required per subarray
- The total volume of TaqMan® OpenArray® Genotyping Master Mix and water required for the project

1. Browse to and open the Sample Tracking & Calculator Tool to start the Excel software.

2. Select the **Master Mix Calculator** tab.

3. In the spreadsheet, enter the required values in Steps 1 through 3.

   **Note:** The tool automatically enters the gDNA value from the gDNA Calculator.

### How much Master Mix should I prepare?

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Enter total number of samples</td>
<td>0</td>
</tr>
<tr>
<td>Step 2</td>
<td>Enter the average for pipetting error (e.g., 10% = 1.1)</td>
<td>0</td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter your gDNA concentration</td>
<td>0</td>
</tr>
</tbody>
</table>

### Calculations

<table>
<thead>
<tr>
<th>Component</th>
<th>Starting Concentration</th>
<th>uL per Reaction</th>
<th>Total uL (including overage)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan OpenArray Master Mix</td>
<td>2x</td>
<td>2.90</td>
<td>0.0</td>
</tr>
<tr>
<td>Nuclease Free Water</td>
<td>#DIV/0!</td>
<td>#DIV/0!</td>
<td>#DIV/0!</td>
</tr>
<tr>
<td>gDNA</td>
<td>#DIV/0!</td>
<td>#DIV/0!</td>
<td>#DIV/0!</td>
</tr>
<tr>
<td>Total Volume</td>
<td>5.00</td>
<td>5.00</td>
<td>0.0</td>
</tr>
</tbody>
</table>

*Take the ng/uL from the gDNA calculator*

The Sample Tracking & Calculator Tool calculates the required volumes.

**Note:** The calculated results are the volumes required for the overall project, not the volumes required per subarray.
Example

The figure below shows the results for 48 samples, a 10% overage, and a stock gDNA concentration at 100 ng/µL (thus, requiring a dilution).

Since the gDNA is double the required concentration, only 1.25 µL of gDNA is required; 1.25 µL of nuclease-free water is required to bring the final sample volume to 2.5 µL.

<table>
<thead>
<tr>
<th>Component</th>
<th>Starting Concentration</th>
<th>µL per Reaction</th>
<th>Total µL (including overage)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan OpenArray Master Mix</td>
<td>2x</td>
<td>2.50</td>
<td>132.0</td>
</tr>
<tr>
<td>Nuclease Free Water</td>
<td></td>
<td>1.25</td>
<td>66.0</td>
</tr>
<tr>
<td>gDNA*</td>
<td>50</td>
<td>1.25</td>
<td>66.0</td>
</tr>
<tr>
<td>Total Volume</td>
<td></td>
<td>5.00</td>
<td>264.0</td>
</tr>
</tbody>
</table>

* Takes the ng/µL from the gDNA calculator
This appendix covers:

- Dual Flat Block GeneAmp® PCR System 9700 ............................... 127
- Bio-Rad® thermal cycler protocol .................................................. 127
- Protocol ......................................................................................... 128
- Thermo Electron PX2 thermal cycler protocol ............................... 129

**Dual Flat Block GeneAmp® PCR System 9700**

For the thermal cycling protocol, refer to the *Dual Flat Block GeneAmp® PCR System 9700 User Guide*.

**Bio-Rad® thermal cycler protocol**

Before programming the thermal cycler, Applied Biosystems recommends installing the Slide Chambers Dual-Block Alpha Unit on the thermal cycler base. If you have a multi-bay base unit, install the Slide Chambers Unit in Bay 1. An error may occur if a program is created with a different block installed on the thermal cycler base.

For additional information and assistance, contact an Applied Biosystems service representative.
Protocol

1. Be sure that the black side of the TaqMan® OpenArray® Genotyping Case is facing up on the block.

2. Follow the manufacturer’s directions to thermal cycle the sealed TaqMan® OpenArray® Genotyping Plates.

3. If you must re-program the Bio-Rad thermal cycler, select the Block method, then enter the following:

<table>
<thead>
<tr>
<th>Step</th>
<th>Temperature and Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.8 °C/second to 95.5 °C</td>
</tr>
<tr>
<td>2</td>
<td>91.0 °C for 10:00</td>
</tr>
<tr>
<td>3</td>
<td>0.5 °C/s to 51.0 °C</td>
</tr>
<tr>
<td>4</td>
<td>51.0 °C for 0:23</td>
</tr>
<tr>
<td>5</td>
<td>0.8 °C/s to 53.5 °C</td>
</tr>
<tr>
<td>6</td>
<td>53.5 °C for 0:30</td>
</tr>
<tr>
<td>7</td>
<td>0.8 °C/s to 54.5 °C</td>
</tr>
<tr>
<td>8</td>
<td>54.5 °C for 0:13</td>
</tr>
<tr>
<td>9</td>
<td>0.8 °C/s to 97.0 °C</td>
</tr>
<tr>
<td>10</td>
<td>97.0 °C for 0:22</td>
</tr>
<tr>
<td>11</td>
<td>0.8 °C/s to 92.0 °C</td>
</tr>
<tr>
<td>12</td>
<td>92.0 for 0:07</td>
</tr>
<tr>
<td>13</td>
<td>Goto 3, 49 times</td>
</tr>
<tr>
<td>14</td>
<td>20 °C for 5:00</td>
</tr>
<tr>
<td>15</td>
<td>4 °C Hold</td>
</tr>
<tr>
<td>16</td>
<td>End</td>
</tr>
</tbody>
</table>
Thermo Electron PX2 thermal cycler protocol

1. Be sure that the black side of the TaqMan OpenArray Genotyping Case is facing up on the block.

2. Place a rubber compression pad on top of the genotyping plates.

3. Follow the manufacturer’s directions to thermal cycle the sealed genotyping plates.

If you must reprogram the PX2 thermal cycler, enter the following in the EDIT menu:

<table>
<thead>
<tr>
<th>Edit menu</th>
<th>View menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>STAGE 01</td>
<td>STAGE 01</td>
</tr>
<tr>
<td>TEMP 92.5</td>
<td>TEMP 92.5</td>
</tr>
<tr>
<td>TIME 0:10:00</td>
<td>TIME 00:10:00</td>
</tr>
<tr>
<td>STAGE 01</td>
<td>STAGE 01</td>
</tr>
<tr>
<td>TEMP 0.00</td>
<td>TEMP 0.05</td>
</tr>
<tr>
<td>TIME 0:00:00</td>
<td>TIME 00:00:00</td>
</tr>
</tbody>
</table>

Note: For STAGE 01, STEP 02, the VIEW menu displays the temperature as TEMP 0.05, even though you have entered 0.00. In the EDIT menu, you can enter only 0.00 °C or a temperature that is ≥ 4 °C.

<table>
<thead>
<tr>
<th>STAGE 02</th>
<th>STAGE 02</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEMP 97.5</td>
<td>TEMP 96.5</td>
</tr>
<tr>
<td>TIME 0:00:35</td>
<td>TIME 0:00:11</td>
</tr>
<tr>
<td>STAGE 02</td>
<td>STAGE 02</td>
</tr>
<tr>
<td>TEMP 96.5</td>
<td>TEMP 0.00</td>
</tr>
<tr>
<td>TIME 0:00:11</td>
<td>TIME 00:00</td>
</tr>
<tr>
<td>STAGE 02</td>
<td>STAGE 02</td>
</tr>
<tr>
<td>TEMP 52.7</td>
<td>TEMP 0.07</td>
</tr>
<tr>
<td>TIME 0:01:55</td>
<td>TIME 00:00</td>
</tr>
<tr>
<td>STAGE 02</td>
<td>STAGE 02</td>
</tr>
<tr>
<td>TEMP 0.00</td>
<td>TEMP 0.00</td>
</tr>
<tr>
<td>TIME: 0:00:00</td>
<td>TIME INC 00:00</td>
</tr>
</tbody>
</table>

Note: For STAGE 02, STEP 04, the VIEW menu displays the temperature as TEMP 0.07, even though you have entered 0.00. In the EDIT menu, you can enter only 0.00 °C or a temperature that is ≥ 4 °C.
### Edit menu

<table>
<thead>
<tr>
<th>STAGE NUMBER</th>
<th>02</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUMBER OF CYCLES</td>
<td>50</td>
</tr>
<tr>
<td>HOLD TEMP</td>
<td>00.0</td>
</tr>
<tr>
<td>STAGE 03</td>
<td>STEP 01</td>
</tr>
<tr>
<td>TEMP</td>
<td>25.00</td>
</tr>
<tr>
<td>TIME</td>
<td>00:02:00</td>
</tr>
<tr>
<td>STAGE 03</td>
<td>STEP 02</td>
</tr>
<tr>
<td>TEMP</td>
<td>0.00</td>
</tr>
<tr>
<td>TIME</td>
<td>00:00:00</td>
</tr>
<tr>
<td>STAGE NUMBER</td>
<td>03</td>
</tr>
<tr>
<td>NUMBER OF CYCLES</td>
<td>01</td>
</tr>
<tr>
<td>HOLD TEMP</td>
<td>00.0</td>
</tr>
<tr>
<td>STAGE 04</td>
<td>STEP 01</td>
</tr>
<tr>
<td>TEMP</td>
<td>0.00</td>
</tr>
<tr>
<td>TIME</td>
<td>00:00:00</td>
</tr>
</tbody>
</table>

### View menu

| STAGE | 02 |
| NUMBER OF CYCLES | 50 |
| HOLD TEMP | 00.0 |
| STAGE 03 | STEP 01 |
| TEMP | 25.00 |
| TIME | 00:02:00 |
| GRADIENT | 00 |
| RAMP | 0.00 |
| STAGE 03 | STEP 02 |
| TEMP | 0.00 |
| TIME | 00:00:00 |
| GRADIENT | 00 |
| RAMP | 0.00 |
| STAGE NUMBER | 03 |
| NUMBER OF CYCLES | 01 |
| HOLD TEMP | 00.0 |
| STAGE 04 | STEP 01 |
| TEMP | 0.00 |
| TIME | 00:00:00 |
| GRADIENT | 00 |
| RAMP | 0.00 |
| STAGE NUMBER | 04 |
| NUMBER OF CYCLES | 01 |
| HOLD TEMP | 00.0 |
Instrument Warranty Information

Computer configuration

Applied Biosystems supplies or recommends certain configurations of computer hardware, software, and peripherals for use with its instrumentation. Applied Biosystems reserves the right to decline support for or impose extra charges for supporting nonstandard computer configurations or components that have not been supplied or recommended by Applied Biosystems. Applied Biosystems also reserves the right to require that computer hardware and software be restored to the standard configuration prior to providing service or technical support. For systems that have built-in computers or processing units, installing unauthorized hardware or software may void the Warranty or Service Plan.

Limited product warranty

Limited warranty

Applied Biosystems warrants that all standard components of its OpenArray® system will be free of defects in materials and workmanship for a period of one (1) year from the date the warranty period begins. Applied Biosystems will repair or replace, at its discretion, all defective components during this warranty period. After this warranty period, repairs and replacement components may be purchased from Applied Biosystems at its published rates. Applied Biosystems also provides service agreements for post-warranty coverage. Applied Biosystems reserves the right to use new, repaired, or refurbished instruments or components for warranty and post-warranty service agreement replacements. Repair or replacement of products or components that are under warranty does not extend the original warranty period.

Applied Biosystems warrants that all optional accessories supplied with its OpenArray® system, such as peripherals, printers, and special monitors, will be free of defects in materials and workmanship for a period of ninety (90) days from the date the warranty begins. Applied Biosystems will repair or replace, at its discretion, defective accessories during this warranty period. After this warranty period, Applied Biosystems will pass on to the buyer, to the extent that it is permitted to do so, the warranty of the original manufacturer for such accessories.

With the exception of consumable and maintenance items, replaceable products or components used on or in the instrument are themselves warranted to be free of defects in materials and workmanship for a period of ninety (90) days.

Applied Biosystems warrants that chemicals and other consumable products will be free of defects in materials and workmanship when received by the buyer, but not thereafter, unless otherwise specified in documentation accompanying the product.
Appendix E  Instrument Warranty Information

Limited product warranty

Applied Biosystems warrants that for a period of ninety (90) days from the date the warranty period begins, the tapes, diskettes, or other media bearing the operating software of the product, if any, will be free of defects in materials and workmanship under normal use. If there is a defect in the media covered by the above warranty and the media is returned to Applied Biosystems within the ninety (90) day warranty period, Applied Biosystems will replace the defective media.

Applied Biosystems does not warrant that the operation of the instrument or its operating software will be uninterrupted or error free.

Warranty period effective date

Any applicable warranty period under these sections begins on the earlier of the date of installation or ninety (90) days from the date of shipment for hardware and software installed by Applied Biosystems personnel. For all hardware and software installed by the buyer or anyone other than Applied Biosystems, and for all other products, the applicable warranty period begins the date the product is delivered to the buyer.

Warranty claims

Warranty claims must be made within the applicable warranty period, or, for chemicals or other consumable products, within thirty (30) days after receipt by the buyer.

Warranty exceptions

The above warranties do not apply to defects resulting from misuse, neglect, or accident, including without limitation: operation with incompatible solvents or samples in the system; operation outside of the environmental or use specifications or not in conformance with the instructions for the instrument system, software, or accessories; improper or inadequate maintenance by the user; installation of software or interfacing, or use in combination with software or products, not supplied or authorized by Applied Biosystems; and modification or repair of the product not authorized by Applied Biosystems.

THE FOREGOING PROVISIONS SET FORTH APPLIED BIOSYSTEMS’ SOLE AND EXCLUSIVE REPRESENTATIONS, WARRANTIES, AND OBLIGATIONS WITH RESPECT TO ITS PRODUCTS, AND APPLIED BIOSYSTEMS MAKES NO OTHER WARRANTY OF ANY KIND WHATSOEVER, EXPRESSED OR IMPLIED, INCLUDING WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WHETHER ARISING FROM A STATUTE OR OTHERWISE IN LAW OR FROM A COURSE OF DEALING OR USAGE OF TRADE, ALL OF WHICH ARE EXPRESSLY DISCLAIMED.

Warranty limitations

THE REMEDIES PROVIDED HEREIN ARE THE BUYER’S SOLE AND EXCLUSIVE REMEDIES. WITHOUT LIMITING THE GENERALITY OF THE FOREGOING, IN NO EVENT SHALL APPLIED BIOSYSTEMS BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE (INCLUDING WITHOUT LIMITATION, ANY TRADE PRACTICE, UNFAIR
COMPETITION, OR OTHER STATUTE OF SIMILAR IMPORT) OR ON ANY OTHER BASIS, FOR DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, MULTIPLE, CONSEQUENTIAL, OR SPECIAL DAMAGES SUSTAINED BY THE BUYER OR ANY OTHER PERSON OR ENTITY, WHETHER OR NOT FORESEEABLE AND WHETHER OR NOT APPLIED BIOSYSTEMS IS ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, INCLUDING WITHOUT LIMITATION, DAMAGES ARISING FROM OR RELATED TO LOSS OF USE, LOSS OF DATA, FAILURE OR INTERRUPTION IN THE OPERATION OF ANY EQUIPMENT OR SOFTWARE, DELAY IN REPAIR OR REPLACEMENT, OR FOR LOSS OF REVENUE OR PROFITS, LOSS OF GOOD WILL, LOSS OF BUSINESS, OR OTHER FINANCIAL LOSS OR PERSONAL INJURY OR PROPERTY DAMAGE.

NO AGENT, EMPLOYEE, OR REPRESENTATIVE OF Applied Biosystems HAS ANY AUTHORITY TO MODIFY THE TERMS OF THIS LIMITED WARRANTY STATEMENT OR TO BIND APPLIED BIOSYSTEMS TO ANY AFFIRMATION, REPRESENTATION, OR WARRANTY CONCERNING THE PRODUCT THAT IS NOT CONTAINED IN THIS LIMITED WARRANTY STATEMENT, AND ANY SUCH MODIFICATION, AFFIRMATION, REPRESENTATION, OR WARRANTY MADE BY ANY AGENT, EMPLOYEE, OR REPRESENTATIVE OF APPLIED BIOSYSTEMS WILL NOT BE BINDING ON APPLIED BIOSYSTEMS, UNLESS IN A WRITING SIGNED BY AN EXECUTIVE OFFICER OF APPLIED BIOSYSTEMS.

THIS WARRANTY IS LIMITED TO THE BUYER OF THE PRODUCT FROM APPLIED BIOSYSTEMS AND IS NOT TRANSFERABLE.

Some countries or jurisdictions limit the scope of or preclude limitations or exclusion of warranties, of liability, such as liability for gross negligence or wilful misconduct, or of remedies or damages, as or to the extent set forth above. In such countries and jurisdictions, the limitation or exclusion of warranties, liability, remedies or damages set forth above shall apply to the fullest extent permitted by law, and shall not apply to the extent prohibited by law.
Damages, claims, and returns

Damages

If shipping damage to the product is discovered, contact the shipping carrier and request inspection by a local agent. Secure a written report of the findings to support any claim. Do not return damaged goods to Applied Biosystems without first securing an inspection report and contacting Applied Biosystems Technical Support for a Return Authorization (RA) number.

Claims

After a damage inspection report is received by Applied Biosystems, Applied Biosystems will process the claim unless other instructions are provided.

Returns

Do not return any material without prior notification and authorization.

If for any reason it becomes necessary to return material to Applied Biosystems, contact Applied Biosystems Technical Support or your nearest Applied Biosystems subsidiary or distributor for a return authorization (RA) number and forwarding address. Place the RA number in a prominent location on the outside of the shipping container, and return the material to the address designated by the Applied Biosystems representative.
This appendix covers:

- Instrumentation safety ................................................. 136
  Symbols on instruments ............................................. 136
  Locations of safety labels on instruments ..................... 137
  General instrument safety .......................................... 138
  Physical hazard safety ............................................... 139
  Electrical safety ...................................................... 140
  Bar code scanner laser safety .................................... 140
  Workstation safety .................................................. 141
  Safety and electromagnetic compatibility (EMC) standards .... 141

- Chemical safety .......................................................... 143
  General chemical safety ............................................ 143
  SDSs ........................................................................ 143
  Chemical waste safety ............................................... 144
  Biological hazard safety ............................................. 145
## Instrumentation safety

### Symbols on instruments

The following table describes the electrical symbols that may be displayed on Applied Biosystems instruments.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="On symbol" /></td>
<td>Indicates the <strong>On</strong> position of the main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Off symbol" /></td>
<td>Indicates the <strong>Off</strong> position of the main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Standby symbol" /></td>
<td>Indicates a standby switch by which the instrument is switched on to the <strong>Standby</strong> condition. Hazardous voltage may be present if this switch is on standby.</td>
</tr>
<tr>
<td><img src="image" alt="On/Off symbol" /></td>
<td>Indicates the <strong>On/Off</strong> position of a push-push main power switch.</td>
</tr>
<tr>
<td><img src="image" alt="Signal ground symbol" /></td>
<td>Indicates a terminal that may be connected to the signal ground reference of another instrument. This is not a protected ground terminal.</td>
</tr>
<tr>
<td><img src="image" alt="Protective ground symbol" /></td>
<td>Indicates a protective grounding terminal that must be connected to earth ground before any other electrical connections are made to the instrument.</td>
</tr>
<tr>
<td><img src="image" alt="Alternating current symbol" /></td>
<td>Indicates a terminal that can receive or supply alternating current or voltage.</td>
</tr>
<tr>
<td><img src="image" alt="Direct current symbol" /></td>
<td>Indicates a terminal that can receive or supply alternating or direct current or voltage.</td>
</tr>
</tbody>
</table>

### Safety symbols

The following table describes the safety symbols that may be displayed on Applied Biosystems instruments. Each symbol may appear by itself or with text that explains the relevant hazard (see “Safety labels on instruments” on page 11). These safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that occur in the text of this and other product-support documents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Exclamation mark" /></td>
<td>Indicates that you should consult the manual for further information and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="image" alt="Electrical hazard symbol" /></td>
<td>Indicates the presence of an electrical shock hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="image" alt="High-temperature hazard symbol" /></td>
<td>Indicates the presence of a hot surface or other high-temperature hazard and to proceed with appropriate caution.</td>
</tr>
</tbody>
</table>
Environmental symbols on instruments

The following symbol applies to all Applied Biosystems electrical and electronic products placed on the European market after August 13, 2005.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Indicates the presence of a laser inside the instrument and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Indicates the presence of moving parts and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Indicates the presence of a biological hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Indicates the presence of a radiological hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Indicates the presence of a slipping hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Indicates the presence of an ultraviolet light and to proceed with appropriate caution.</td>
</tr>
</tbody>
</table>

Do not dispose of this product as unsorted municipal waste. Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of waste electrical and electronic equipment (WEEE).

**European Union customers:** Call your local Applied Biosystems Customer Service office for equipment pick-up and recycling. See [www.appliedbiosystems.com](http://www.appliedbiosystems.com) for a list of customer service offices in the European Union.

Locations of safety labels on instruments

The OpenArray® platform includes the following warning on the OpenArray® Case Sealing Station:

<table>
<thead>
<tr>
<th>Hazard symbol</th>
<th>English</th>
<th>Français</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td><strong>CAUTION!</strong> UV LIGHT HAZARD. UV light may harm your skin and eyes. Keep at least 25 cm distance.</td>
<td><strong>ATTENTION!</strong> Dangers liés aux rayons UV. Les rayons UV peuvent endommager votre peau et vos yeux. Gardez une distance de plus de 25 cm.</td>
</tr>
</tbody>
</table>
General instrument safety

WARNING! PHYSICAL INJURY HAZARD. Use this product only as specified in this document. Using this instrument in a manner not specified by Applied Biosystems may result in personal injury or damage to the instrument.

WARNING! PHYSICAL INJURY HAZARD. Using the instrument in a manner not specified by Applied Biosystems may result in personal injury or damage to the instrument.

CAUTION! For safety information related to the centrifuge and thermal cycler, refer to the manufacturer's documentation.

Moving and lifting the instrument

CAUTION! PHYSICAL INJURY HAZARD. The instrument is to be moved and positioned only by the personnel or vendor specified in the applicable site preparation guide. If you decide to lift or move the instrument after it has been installed, do not attempt to lift or move the instrument without the assistance of others, the use of appropriate moving equipment, and proper lifting techniques. Improper lifting can cause painful and permanent back injuries. Depending on the weight, moving or lifting an instrument may require two or more persons.

CAUTION! Do not tip the OpenArray® instrument on end. Tipping damages the instrument hardware and electronics and is an unsafe practice.

Moving and lifting stand-alone computers and monitors

WARNING! Do not attempt to lift or move the computer or the monitor without the assistance of others. Depending on the weight of the computer and/or the monitor, moving them may require two or more people.
Things to consider before lifting the computer and/or the monitor:
- Make sure that you have a secure, comfortable grip on the computer or the monitor when lifting.
- Make sure that the path from where the object is to where it is being moved is clear of obstructions.
- Do not lift an object and twist your torso at the same time.
- Keep your spine in a good neutral position while lifting with your legs.
- Participants should coordinate lift and move intentions with each other before lifting and carrying.
- Instead of lifting the object from the packing box, carefully tilt the box on its side and hold it stationary while someone slides the contents out of the box.

Operating the instrument
Ensure that anyone who operates the instrument has:
- Received instructions in both general safety practices for laboratories and specific safety practices for the instrument.
- Read and understood all applicable Safety Data Sheets (SDSs). See “About SDSs” on page 143.

Cleaning or decontaminating the instrument

CAUTION! Before using a cleaning or decontamination method other than those recommended by the manufacturer, verify with the manufacturer that the proposed method will not damage the equipment.

Physical hazard safety

Ultraviolet light

WARNING! ULTRAVIOLET LIGHT HAZARD. Looking directly at a UV light source can cause serious eye damage. Never look directly at a UV light source and always prevent others from UV exposure. Follow the manufacturer’s recommendations for appropriate protective eyewear and clothing.

Compressed gases

WARNING! EXPLOSION HAZARD. Pressurized gas cylinders are potentially explosive and can cause severe injury if not handled properly. Always cap the gas cylinder when it is not in use and attach it firmly to the wall or gas cylinder cart with approved brackets or chains.

Moving parts

WARNING! PHYSICAL INJURY HAZARD. Moving parts can crush and cut. Keep hands clear of moving parts while operating the instrument. Disconnect power before servicing the instrument.

Solvents and pressurized fluids

WARNING! PHYSICAL INJURY HAZARD. Always wear eye protection when working with solvents or any pressurized fluids.
Appendix F  Safety

Instrumentation safety

Electrical safety

**WARNING! ELECTRICAL SHOCK HAZARD.** Severe electrical shock can result from operating the OpenArray® instrument without its instrument panels in place. Do not remove instrument panels. High-voltage contacts are exposed when instrument panels are removed from the instrument.

**WARNING! ELECTRICAL HAZARD.** Grounding circuit continuity is required for the safe operation of equipment. Never operate equipment with the grounding conductor disconnected.

**WARNING! ELECTRICAL HAZARD.** Use properly configured and approved line cords for the voltage supply in your facility.

**WARNING! ELECTRICAL HAZARD.** Plug the OpenArray® platform components into properly grounded receptacles with adequate current capacity.

Overvoltage rating

The OpenArray® platform has an installation (overvoltage) category of II, and is classified as portable equipment.

Bar code scanner laser safety

**Laser classification**

The bar code scanner included with the OpenArray® platform is categorized as a Class 2 (II) laser.

**Laser safety requirements**

Class 2 (II) lasers are low-power, visible-light lasers that can damage the eyes. Never look directly into the laser beam. The scanner is designed to prevent human access to harmful levels of laser light during normal operation, user maintenance, or during prescribed service operations.

**WARNING! LASER HAZARD.** Class 2 (II) lasers can cause damage to eyes. Avoid looking into a Class 2 (II) laser beam or pointing a Class 2 (II) laser beam into another person's eyes.
Workstation safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your workstation to promote neutral or relaxed working positions.

CAUTION! MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD.
These hazards are caused by potential risk factors that include but are not limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:
- Use equipment that comfortably supports you in neutral working positions and allows adequate accessibility to the keyboard, monitor, and mouse.
- Position the keyboard, mouse, and monitor to promote relaxed body and head postures.

Safety and electromagnetic compatibility (EMC) standards

This section provides information on:
- U.S. and Canadian safety standards
- Canadian EMC standard
- European safety and EMC standards
- Australian EMC Standards

U.S. and Canadian safety standards
The OpenArray® AutoLoader, OpenArray® Case Sealing Station, and OpenArray® instrument have been tested to and comply with the standards:

Canadian EMC standard
The OpenArray® AutoLoader, OpenArray® Case Sealing Station, and OpenArray® instrument have been tested to and comply with ICES-001, Issue 3: “Industrial, Scientific, and Medical Radio Frequency Generators.”

European safety and EMC standards
Safety
The OpenArray® AutoLoader, OpenArray® Case Sealing Station, and OpenArray® instrument meet European requirements for safety (Low Voltage Directive 73/23/EEC). This instrument has been tested to and complies with standards EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and Laboratory Use, Part 1: General Requirements.”

The OpenArray® instrument has been tested to and complies with the standard: EN 60825-1, “Radiation Safety of Laser Products, Equipment Classification, Requirements, and User’s Guide.”
EMC

This instrument meets European requirements for emission and immunity (EMC Directive 89/336/EEC). This instrument has been tested to and complies with standard EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and Laboratory Use – EMC Requirements.”

Australian EMC Standards

The OpenArray® AutoLoader, OpenArray® Case Sealing Station, and OpenArray® instrument have been tested to and comply with standard AS/NZS 2064, “Limits and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
Chemical safety

General chemical safety

Chemical hazard warning

⚠️ WARNING! CHEMICAL HAZARD. Before handling any chemicals, refer to the Safety Data Sheet (SDS) provided by the manufacturer, and observe all relevant precautions.

⚠️ WARNING! CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical safety guidelines

To minimize the hazards of chemicals:

- Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. (See “About SDSs” on page 143.)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the SDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the SDS.
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended in the SDS.
- Comply with all local, state/provincial, or national laws and regulations related to chemical storage, handling, and disposal.

SDSs

About SDSs

Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments of hazardous chemicals to new customers. They also provide SDSs with the first shipment of a hazardous chemical to a customer after an SDS has been updated. SDSs provide the safety information you need to store, handle, transport, and dispose of the chemicals safely.

Each time you receive a new SDS packaged with a hazardous chemical, be sure to replace the appropriate SDS in your files.

Obtaining SDSs

The SDS for any chemical supplied by Applied Biosystems is available to you free 24 hours a day. To obtain SDSs:

1. Go to www.appliedbiosystems.com, click Support, then select SDS.
2. In the Keyword Search field, enter the chemical name, product name, SDS part number, or other information that appears in the SDS of interest. Select the language of your choice, then click Search.
3. Find the document of interest, right-click the document title, then select any of the following:
   • **Open** – To view the document
   • **Print Target** – To print the document
   • **Save Target As** – To download a PDF version of the document to a destination that you choose

Note: For the SDSs of chemicals not distributed by Applied Biosystems, contact the chemical manufacturer.

### Chemical waste safety

#### Chemical waste hazards

| CAUTION! HAZARDOUS WASTE. Refer to Safety Data Sheets and local regulations for handling and disposal. |
| WARN! CHEMICAL WASTE HAZARD. Wastes produced by Applied Biosystems instruments are potentially hazardous and can cause injury, illness, or death. |
| WARN! CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles. |

#### Chemical waste safety guidelines

To minimize the hazards of chemical waste:

- Read and understand the Safety Data Sheets (SDSs) provided by the manufacturers of the chemicals in the waste container before you store, handle, or dispose of chemical waste.

- Provide primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)

- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the SDS.

- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the SDS.

- Handle chemical wastes in a fume hood.

- After emptying a waste container, seal it with the cap provided.

- Dispose of the contents of the waste tray and waste bottle in accordance with good laboratory practices and local, state/provincial, or national environmental and health regulations.
If potentially hazardous waste is generated when you operate the instrument, you must:

- Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.
- Ensure the health and safety of all personnel in your laboratory.
- Ensure that the instrument waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.

**IMPORTANT!** Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.

### Biological hazard safety

#### General biohazard

**WARNING! BIOHAZARD.** Biological samples such as tissues, body fluids, infectious agents, and blood of humans and other animals have the potential to transmit infectious diseases. Follow all applicable local, state/provincial, and/or national regulations. Wear appropriate protective equipment, which includes but is not limited to: protective eyewear, face shield, clothing/lab coat, and gloves. All work should be conducted in properly equipped facilities using the appropriate safety equipment (for example, physical containment devices). Individuals should be trained according to applicable regulatory and company/institution requirements before working with potentially infectious materials. Read and follow the applicable guidelines and/or regulatory requirements in the following:

- U.S. Department of Health and Human Services guidelines published in *Biosafety in Microbiological and Biomedical Laboratories* (stock no. 017-040-00547-4; [bmbl.od.nih.gov](http://bmbl.od.nih.gov)).
- Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR§1910.1030; [www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html](http://www.access.gpo.gov/nara/cfr/waisidx_01/29cfr1910a_01.html)).
- Your company's/institution's Biosafety Program protocols for working with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at: [www.cdc.gov](http://www.cdc.gov)
Documentation and Support

System documentation

The following documents are available for the OpenArray® system:

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>OpenArray® System Site Preparation Guide</em></td>
<td>Provides information on preparing the customer site for the OpenArray® system.</td>
<td>4401171</td>
</tr>
<tr>
<td><em>TaqMan® OpenArray® Genotyping Troubleshooting Guide</em></td>
<td>Provides troubleshooting information for TaqMan® OpenArray® Genotyping. To be used in conjunction with the <em>TaqMan® OpenArray® Genotyping Getting Started Guide</em>.</td>
<td>4401671</td>
</tr>
<tr>
<td><em>TaqMan® OpenArray® Genotyping Getting Started Guide</em></td>
<td>Provides procedures for performing TaqMan® OpenArray® Genotyping.</td>
<td>4377476</td>
</tr>
<tr>
<td><em>TaqMan® OpenArray® Genotyping Quick Reference Card</em></td>
<td>Describes the overall workflow and provides brief procedures for performing TaqMan® OpenArray® Genotyping.</td>
<td>4400402</td>
</tr>
</tbody>
</table>

Related documentation

When using this Guide, you may find the documents listed below useful. To obtain this and additional documentation, see “Obtaining support” on page 148.

<table>
<thead>
<tr>
<th>Document</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Application Note: DNA Genotyping from Human FFPE Samples – Reliable and Reproducible</em></td>
<td>137AP04-01</td>
</tr>
<tr>
<td><em>Bioinformatic Evaluation of a Sequence for Custom TaqMan® SNP Genotyping Assays</em></td>
<td>4371003</td>
</tr>
<tr>
<td><em>Ordering TaqMan® SNP Genotyping Assays Quick Reference Card</em></td>
<td>4374204</td>
</tr>
<tr>
<td><em>TaqMan® SNP Genotyping Assays Protocol</em></td>
<td>4332856</td>
</tr>
<tr>
<td><em>User Bulletin: Human DNA Sample Quantification Protocol Using the RNase P Kit</em></td>
<td>4342582</td>
</tr>
</tbody>
</table>
Obtaining support

For the latest services and support information for all locations, go to:

www.appliedbiosystems.com

At the Applied Biosystems web site, you can:

• Access worldwide telephone and fax numbers to contact Applied Biosystems Technical Support and Sales facilities.
• Search through frequently asked questions (FAQs).
• Submit a question directly to Technical Support.
• Order Applied Biosystems user documents, SDSs, certificates of analysis, and other related documents.
• Download PDF documents.
• Obtain information about customer training.
• Download software updates and patches.


Glossary

cluster center
On the Scatter Plot, the user-defined or automatically calculated cluster midpoint of datapoints for each genotype. Each cluster center appears as a circled X.

cluster lines
On the Scatter Plot, lines that bisect each genotype cluster drawn from the clustering axis to the cluster center.

DNA sample
The DNA from any source of interest (for example, tissue, whole organism, cDNA library).

Don’t Call
User designation that a datapoint not be called. The point appears cyan in the Scatter Plot.

duplicate
An assay is performed “in duplicate” when two through-holes are filled with the same assay/sample combination and a genotype call is made.

Entr.
Abbreviation for ENTER used in the OpenArray® AutoLoader display.

home(s)
An OpenArray® AutoLoader operation that calibrates robotic movement.

load position
The OpenArray® AutoLoader configuration when you begin loading samples into a TaqMan® OpenArray® Genotyping Plate.

No Call
Designation in the software that a genotype has not been called. The point appears black in the Scatter Plot.

OpenArray® 384-Well Sample Plate
A 384-well microtiter plate that you use with the OpenArray® AutoLoader to transfer DNA samples to a TaqMan® OpenArray® Genotyping Plate. Also referred to as the sample plate.

OpenArray® platform
Refers to all of the instrument components of the system, including:

- OpenArray® AutoLoader
- OpenArray® Case Sealing Station
- OpenArray® instrument
- Computer, running the OpenArray® SNP Genotyping Analysis Software

Outlier
User designation that a datapoint not be included in genotype calculations or displayed in the Scatter Plot.

plate guide
When loading sample with the OpenArray® AutoLoader, the part that you place over the sample plates to ensure the correct samples are loaded. Two plate guides are included in the OpenArray® Plate Guide Set.
Glossary

plate holder Accurately positions the TaqMan® OpenArray® Genotyping Plate for sample loading in the OpenArray® AutoLoader.

replicate Experiments performed with the OpenArray® system, in which the same sample/assay combination is performed in multiple through-holes.

stringency In the software Point tab, the number of standard deviations from cluster lines to the datapoints that are included in genotype calls. Datapoints greater than this number of standard deviations are automatically assigned No Call status.

TaqMan® assay The assays that are dried-down and preloaded into the TaqMan® OpenArray® Genotyping Plate. You can select any combination of the following TaqMan assays:
- TaqMan® SNP Genotyping Assays
- Custom TaqMan® SNP Genotyping Assays
- TaqMan® Drug Metabolism Genotyping Assays

TaqMan® OpenArray® Genotyping Plate A 63-mm × 19-mm mid-density reaction plate. The TaqMan® OpenArray® Genotyping Plate consists of individual through-holes that are preloaded with a TaqMan® assay. Available in six formats. Also referred to as the genotyping plate.

target The nucleic acid sequence that you want to amplify and detect.

tip block The OpenArray® AutoLoader Tip Block. The tip block holds 48 loader tips for sample loading with the OpenArray® AutoLoader.

tolerance In the software Point tab, datapoints that are too close to more than one cluster line to be accurately genotyped. These datapoints are automatically assigned No Call status. Tolerance is the indicator of excessive closeness, measured in standard deviations.
Symbols

*.nix. See project file 64
*.spd. See plate data file 65
*.spf. See plate setup file 64

A
add columns 74
adjust genotyping clusters 94
adjust stringency 97
adjust tolerance 98
analysis
   troubleshooting 120
   view results 82
Applied Biosystems
   contacting for maintenance 109
Assays pane
   column descriptions 84
   view data 83
Auto functions 92
AutoCaller Software, downstream analysis 108
Auto-Classification Wizard 94

B
biohazardous waste, handling 145

C
calibrate the OpenArray AutoLoader 113
CAUTION, description 9
chemical safety 143
chemical waste safety 144
clean
   genotyping case 60
   hard drive 112
   OpenArray AutoLoader accessories 113
   OpenArray AutoLoader exterior and interior 112
   OpenArray® instrument exterior 116
   OpenArray® instrument lens 114
   OpenArray® instrument sample block 116
   clustering parameters
      adjust genotyping clusters 94
      adjust stringency 97
      adjust tolerance 98
      draw genotyping clusters 101
      exclude genotyping clusters 99
      modify 92
      set Don’t Call samples 99
      set outliers 93
   columns
      add 74
      Assays pane 84
      delete 76
      Samples pane 92
   components 13
   compressed gases, safety. See also pressurized fluids, safety 139
   computer
      clean hard drive 112
      configuration requirement 131
      install OpenArray software 111
      maintenance 111
      open OpenArray software for first time 111
      purpose 13
      technical support for altered configuration 131

D
DANGER, description 10
data collection 14
data files 64
datapoint colors 87
delete columns 76
DNA
   procedure for preparing human DNA 24
   quality 23
   quantity 23
   template amount 23
Don’t Call samples 99
downstream analysis, AutoCaller Software 108
drag and drop 94
Index

draw genotyping clusters 101

electrical safety 140
electromagnetic compatibility standards. See EMC standards
EMC standards 141
enter sample information 68, 69, 71
ergonomics, safety 141
error messages 117, 120, 122
exclude genotyping clusters 99
export *.csv file 106
export genotype table 105

guidelines
chemical safety 143
chemical waste disposal 144
chemical waste safety 144
handling genotyping plate 50
high-throughput loading 62

imaging 80
perform 78
troubleshooting 117

instrument operation, safety 139

laser classification 140
laser safety
bar code scanner 140
requirements 140

loading
complete for genotyping plate 61
guidelines for high-throughput 62
tip blocks 52
troubleshooting 117
M
maintenance 109, 127
   computer 111
   contact Applied Biosystems 109
   OpenArray AutoLoader and accessories 112
   OpenArray® instrument 114
   required materials 110
mismatch, in genotyping experiments 18
modifying clustering parameters 92
moving and lifting safety
   computers and monitors 138
   instrument 138
moving parts, safety 139
MSDs. See SDSs 143

N
no template controls 17

O
open a project file 82
OpenArray 384-Well Sample Plate. See sample plate 15
OpenArray AutoLoader
   calibrate 113
   clean accessories 113
   clean exterior and interior 112
   illustration 54
   maintenance 112
   purpose 13
   set up 55
OpenArray Case Sealing Station, purpose 13
OpenArray SNP Genotyping Analysis Software. See OpenArray software 64
OpenArray software
   add columns 74
   add plate data file 102
   adjust genotyping clusters 94
   adjust stringency 97
   adjust tolerance 98
   Assays pane 83
   Auto functions 92
   Auto-Classification Wizard 94
   data files 64
   delete columns 76
   drag and drop genotyping clusters 94
   draw genotyping clusters 101
   enter genotyping plate serial number 67
   enter sample information 68
   exclude genotyping clusters 99
   import sample information 71
   install on computer 111
   manually enter sample information 69
   messages 117, 120, 122
   modify cluster shapes 96
   modify clustering parameters 92
   modify project files 102
   open a project file 82
   open for first time 111
   plate data file 65
   plate setup file 64
   project file 64
   publish data 105
   remove plate data file 103
   sample information file 65
   Samples pane 88
   Save function 92
   Scatter Plot 85
   set Don’t Call samples 99
   set outliers 93
   set project parameters 103
   set up 66
   starting 66
   view results 82
OpenArray® instrument
   clean the exterior 116
   clean the lens 114
   clean the sample block 116
   commands 78
   maintenance 114
   perform imaging 80
   place genotyping plate into 79
   purpose 13
   starting 66
ordering genotyping plate 46
outliers 93
overvoltage category (rating) 140

P
physical hazard safety 139
plate data file
   add to project 102
   description 65
   remove from project 103
plate holder
   placing genotyping plate in 50
Index

plate setup file
  copy to computer 66
description 64
platform components 13
positive controls 17
prepare the DNA samples 23
  procedure for human DNA 24
  quality of DNA 23
  quantity of DNA 23
prepare the genotyping plate
  required materials 46
prepare the sample plate
  required materials 22
pressurized fluids, safety 139
project file
  add plate data file 102
description 64
  exporting sample information from 30
  modify 102
  open 82
  remove plate data file 103
  set project parameters 103
project parameters 103
publish data 105
  export *.csv file 106
genotype table 105
  Scatter Plot 105

R
RA number. See return authorization number
radioactive waste, handling 145
repetitive motion, safety 141
replicates 17
required materials
  maintenance 110
  prepare the genotyping plate 46
  prepare the sample plate 22
  storage conditions 48
return authorization (RA) number 134

S
safety
  bar code scanner 140
  before operating the instrument 138
  biological hazards 145
  chemical 143
  chemical waste 144
  compressed gases 139
  electrical 140
  ergonomic 141
  guidelines 143, 144, 145
  instrument operation 139
  laser 140
  moving and lifting computers and monitors 138
  moving and lifting instrument 138
  moving parts 139
  physical hazard 139
  pressurized fluids. See also compressed gases,
safety
  repetitive motion 141
  solvents 139
  standards 141
  ultraviolet light 139
  workstation 141
safety labels, on instruments 11, 137
safety standards 141
safety symbols, on instruments 136
sample 17
sample information
  add columns 74
  delete columns 76
  enter into OpenArray software 68
  import 71
  manually enter 69
sample information file
  description 65
  export from a project file 30
  spreadsheet or simple text 30
sample plate
  format 128 setup 40
  format 16 setup 35
  format 192 setup 41
  format 256 setup 42
  format 32 setup 37
  format 64 setup 39
  illustration 33
  overview 15, 33
  prepare the DNA samples 23
  required materials 22
  storing 44
Samples pane
  column descriptions 92
  view data 88
Save function 92
Scatter Plot
  copy and paste 105
Index

datapoint colors 87
view data 85
SDSs
- about 10
- description 143
- obtaining 143, 148
sealing genotyping case 58
serial number 67
solvents, safety 139
standards
- EMC 141
- safety 141
storage conditions 48
- sample plate 44
stringency 97
symbols, safety 136
system
- maintenance 109, 127
- workflow 19
system overview 13

T
TaqMan assays 16
TaqMan OpenArray Genotyping Case. See genotyping case 58
TaqMan OpenArray Genotyping Plate. See genotyping plate 16
technical support, for computers with altered configuration 131
thermal cycler 14
- Bio-Rad protocol 127
- qualified 61
- Thermo Electron PX2 protocol 129
tip blocks
- loading 52
tolerance 98
training, information on 148
troubleshooting
- analysis 120
- imaging 117
- loading sample 117
- miscellaneous 122

U
ultraviolet light, safety 139

V
view data
- Assays pane 83
- open a project file 82
- Samples pane 88
- Scatter Plot 85

W
WARNING, description 10
warranty
- exceptions 132
- for computers with altered configuration 131
- limitations 132
- period 131
warranty claims 132
warranty exceptions 132
warranty period, effective date 132
waste disposal, guidelines 145
waste profiles, description 145
workflow 19
workstation safety 141
Technical Resources and Support

For the latest technical resources and support information for all locations, please refer to our Web site at

www.appliedbiosystems.com/support